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"Yeah, that was me. | wuz inna big time. [A

‘I had it all...wealth...power...adulation o' millions...and
remember, this was back when that was a lot.”

WATIN' ON DA

LEVEE...WATIN' ON

DA LEVEE..FO' DA
ROBERT E. LEE!

E?Af?g Sy
By o
il And)

KLeP!

"Yeah...that was before...when yer
ridin® high, ya think yer never gonna
fall... fhan fhe ik cragps forn on ya..)' A
2 L] MAMMY .. WHERE YA GOIN?!
] DONTCHA KNOY ME?P IT'S ME!

YER LI'L BUGGY BABY BOY...
fCCHIE HOME O Y4...!

sniff...choke...sob...
how like Tife...honk..

(] A5 A4 BUT TOO MUCH IS

ity el g e
IN 7 EACH L4785 SOME Al
FALLLNAELIN MENE...

= %

"...theater managers started talkin' to me in word

had them Tittle icicles hangin' off 'em...oh, you can tell..."”

RO EY R e e R o

E TN s

wK"N FROM NATCHEZ TO
MOBILE...FROM MEMPHIS TO

PALM SPRINGS...

§wscsdre TN

How about that
Polly, ladeez and
gennemumm...and
now, let's hear an

encouraging

welcome for a

professional composure...”

(v

f A BOOKING? | MAY, PERHAPS, FOR OLD
balloons that had been customized with FatBits so they ! TIMES' SAKE (and a small financial

I remuneration) BE ABLE TO ARRANGE FIFTH

i BILLING FOR YOO, BEHIND POLLY AMND HER

8 PRANCING PIT BOLLS...

.y i . 4 “We regret that
Finally, one night, | kinda Test my ] your albilities u
E| longer guit our
-:1?1 needs at the
iz preseat time.
ik Your resame will

o be kept on file!

sentimental

ite | YERALL sCUM vamomES?|

Mo it e H HOPE YYOU ALL DIE COME ON UP
mokihd to it 1 1| HERE, | DARE YOU! YEAH, YOU
~ K BUDDY!I'M TALKIN' TO YOU!

Broadway i M

Bug! BAL
\' Aw, gidaddahere!!

ARSIy AL

The Comic Strip Factory User Manual

“| gone...a seasoned performer &

HEY PAL, I'M
ST!

A . Nerd"

"Ya have to know when to
leave...when the magic is &@l

kin sense it in a thousand =
different ways...subtle things...
oh, you know, believe me_.."

92992228
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ﬁjﬁn“f‘:‘*—_——“ S0 NOW HERE | AM READY TO RING
';.. DOWN TH' CORTAIN ONNA LAST
SHOW... AND THE BOS I'M TRYIN' TA
THROW MYSELF UNDER IS LATE! 'L
WAIT ANOTHER TEN MINOTES...THEN I'M

FOR THE LOVV A MIKE! |
# (1 DELSHANNON! FORMER '
4 LOVE O' MY LIFE! WHAT ERTidy

*

ARE YOU DOIN' HERE? [N

GONNA GET DEPRESSED'

YES, BROADWAY:ITISI, |
YQOUR LOST LOVE. HERE TO

5 N

HAONT YOO WITH THE .| H MY SCENE. AN'| TOLDJA, |
MEMORY OF YOUR SHAMEFUL 1 WAS WITH A OS0O TROUPE; |
ABANDONMENT! J G725 H WOULDA' BEEN SHOT FOR

T - e g 8 35S DESERTION...

|.1'
fif
* Q‘

ﬁ
e

AW, HAVE A HEART, BABE.
 THAT JONGLE JOST WASN'T

THAT WHICH IS IN THE

o ; 5 PAST IS THAT WHICH
e [ f ; HAS PREVIOUSLY
‘*\7’3 OCCURRED, MY INSECT. |
1,.;,, @, AM HERE TO GIVE YOU A
S CHANCE...FOR A FUTORE.

FOTORE? WHATCHOO

WHOOP! HMM...WHUZZIS? "CSF

; . o |5 REMOTE CONTROL ONIT, iEg e
TALKIN' BOOT, BABE® I‘AIN TEZ  PROPERTY A. WIZ.” HOMPH. _ s WHOAH! 'vE £
GOT NO FOTURE. DIDN'T YA WONDER WHAT THIS DOES... [5 p%i GOME OVER THE

READ THE FIRST PAGE? - BORDER‘

HEY, WHERE YA GOIN?! “| CARELESSLY PRESSED, :

N

N

"Free from

Panel”
3 7 JedbsR 52 1 MAY | SEE YOUR H g R
.l 3 i PASSPORT, " ?}:{ii 2 | "He pushed 'Change Background'

¢ 3 . PLEASE? % ¢ g2t V] | on the remote control unit.”
§ 7 H B * 5

THE BUTTON MARKED...

“"BOT IDON'T ]
KNOW WHERE
M GOING!

ALLOW

D\
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" W YOU'RE TRAVELING =
THROUGH ANOTHER
DEMENTIA..._

HEY, WEREN'T
YOU THE THEATER
MANAGER?

¥ [ reaLLya
WHACKY GIZMO?

"4 'CHONK=STYLE' MATTER
TRANSPORTER?” | SAID,
"HOW GOOD COULD THAT
BE?" "WHO CARES?" HE
SAID, "IT'S ON SALE.” "WELL
SOREIT IS,” | SAID... — RN

GIZMO', EARTH-
BOUG, IS MY MOST k3
POWERFUL TOOL
OF CONJURATION.
IT WAS TAKEN
FROM ME IN AN
EVIL NETHER-
WORLD IN THE
COOURSE OF A

GAME OF
CHANCE.

: m“. . HEY, THAT

THIS "WHACKY [

{ THE ARTIST ONLY HAS |
ONE CHARACTER

| DISK FINISHED, GIMME

A BREAK...

NOW BEGINS AN
INCREDIBLE JOORNEY!
PUSH "ONGROOP!”

. ;\§§ )
P

AH, YOU HAVE
RETURNED '~ITH

| THANK YOU
FORITS SAFE

MY TICKET TO

ll'

D
'y 1)

COMPLETED YOUR TASK.
VANISH BACK INTO THE ':,.,. (4
FOOUL ETHER FROM WHICH ||I|I |
7 | DID SOMMON YOO, >
A FOUT, DEMON! BEGONE!

The Comic Strip Factory User Manual

| BETTER NOT! | WAS JOST
ASTED IN FROM A MACPAINT
ILE AND MODIFIED. | CAN'T BE

kin move a
finger...

1 THAT WHICH CAN

;{ DELIVER TO ME MY

{ HEART'S DESIRE,
OR VICE VERSA.

T
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urnm...feet

seem to be : REALLY? A
3 MACPAINT FILE? HA!
ONFORTONATE SLOB! |
WAS LOADED AS A
PARTS FILE, ALLOWING
PERFECT EASE OF
RELOADING!

this fellow out
of the way.

g YOOUR RELOADING

1 NETWORKS IN FINAL FORM TO BE ™ &

" | wonder what happens if the spell
wears off while I'm up here? _

OOOH, | HATE THAT! |
HATE IT WHEN YOO DO
THAT! WHEN YOO THRILL
FRIENDS... ALWAYS
WITH THE THRILLING
FRIENDS...

N W N

LOOK, GUYS, | JOST NEED TO OSE THAT
| THING ONCE! | WANNA GO SOMEPLACE
WHERE | CAN BE LOVED AND
APPRECIATED AGAIN...SOMEPLACE
WHERE THEY APPRECIATE REAL
ENTERTAINMENT VALOUE... MY KIND OF

HA! WHAT CARE 1 FOR [

EASE? SAVED AS
MACPAINT, | CAN BE
BE MODIFIED AND
THEN DISTRIBOTED
THROUGH MAC

VIEWED BY OTHERS AND THRILL j=
FRIENDS! CAN YOU DO THAT!? JY"

T

YOU ALWAYS THROW
THAT OP TO ME! LIKE
YOU'RE BETTER THAN ME
'COZ YOU GOT FRIENDS! |

gl

WHO'S PAYING
THE F:'IEN:I HERE,

OH? WELL, THAT'S ~
EASY ENOOGH.
WHY DIDN'T YOU

53“@@ -4 -‘ccl;}”‘ $
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Bl@le Overl

3rd Bfg Light Year!!
"Hero of the Asteroid!"

PEOPLE ALLUS TOLD
ME... BE CAREFOL
WHATCHA DO...

SLEP, SLEP, SLEP,
SLEPPY, S1LED, SILED

“and | owe it all to Comic Strip
Factory! God love ya fellas. |
mean that sincerely...”

The Comic Strip Factory User Manual
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Before You Begin

Installing The Comic Strip Factory on Another Disk

The Cornic Strip Factory is not copy protected. We decided against
copy protection because we, as Macintosh users, hate dealing
with copy protected software. As hard disk owners, we hate it even
more. For easier access to the program and its data files, you may
want to install The Comic Strip Factory on a hard disk, if you have
one. If you intend to use the program from floppy disk, you should
make a copy of the disks, work from the copies, and put the
originals in a safe place.

(Just because the program isn’t copy protected doesn’t mean it
isn’t copyrighted, however. You can legally copy the program for
the purposes mentioned above, but you are not allowed to give
copies to other people.)

Because the program isn’t copy protected, installing The Comic
Strip Factory on the hard disk is easily done. Using the Finder,
copy all the files from The Comic Strip Factory disks, except the
files in the System Folder on the Program disk. Actually, you don’t
have to copy them all. The Comic Strip Factory doesn’t use any
files but the ones you tell it to use, so you can arrange the files in
folders entirely to suit your own working style.

Before You Begin




If you aren’t sure how to use the Finder to copy files, consult the
manual that came with your Macintosh.

Using The Comic Strip Factory Fonts

You don’t want to copy the Finder and System to a hard disk
because hard disks shouldn’t have more than one System file on
them. You do, however, want to get the fonts from our System file
and put them into your System file.

The System file on The Comic Strip Factory Program Disk contains
several fonts designed for comic strips. They are:

Beach 12 point

BeachBold 12, 14
Beact: falic 12

Beach Emphatic (bold-italic ) 18, 14
CANYON 12

These fonts are designed to mimic hand-lettered styles of
professional comic letterers. The characters in the fonts are about
the same size as those in standard twelve and fourteen point
fonts, but the leading (the space between the bottom or a line and
the top of the next) is tighter (there’s less of it). This is consistent
with lettering in most comic books and strips, where space is at a
premium. Also, there are a slew of special characters in the fonts.
Open up the Key Caps desk accessory, select one of our fonts from
the Key Caps menu, and hold down the Option and Shift keys to
see them.

Typically, you can’t use fonts if they aren’t in the current System
file. So if you run The Comic Strip Factory from a hard disk, you
should use Apple’s Font/DA Mover to copy the fonts into the
System file on that disk.

Certain utilities now available allow you to use fonts without
installing them in your System file. If you use one of these
utilities, follow the instructions that came with it to make The
Comic Strip Factory fonts useable on your computer. This will
probably still involve using Font/DA Mover to copy the fonts from

The Comic Strip Factory User Manual
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our System file, so if you don’t know how to use Font/DA Mover,
consult your Macintosh manuals.

We Know You're Not Going To Read This

And we understand. Already, you probably know what you've got
here. You know what it means to suddenly have the camera, the
crew, the sets, the props, and the actors all in place, awaiting
your direction. You appreciate the potential of the graphic story
medium. We know, then, that there’s nothing to keep you from:

Trying To Do It All At Once

Yes: You're going to start writing before you've got a story, and
torture the panels (those boxes where comics happen) into strange
and unnatural shapes, and throw in characters without a thought
as to what to do with them. Go ahead. We’'ll wait for you here. But
before you go, we urge you to at least peruse this basic rhythm
system to keep your errant doodling from bogging down and
collapsing entirely right at the start, causing you to bellow “No
fun! Dumb program!” and hurl the disk at the wall:

1. From the title page, click OK. From the Open dialog, click
New to create a new comic strip.

2. Default past the page parameters by pressing Return or
clicking OK.

3. From the File menu, choose Open... and click on the Parts
radio button.

Select a parts file that looks interesting.
Shift-click over several character body parts.

From the Panel menu, choose Copy to Panel.

SO

Arrange parts in the panel in an aesthetically pleasing
fashion. From the Arrange menu, use Bring to Front and
Send to Back to place hats firmly on heads, canes in hands,

We Know You're Not Going To Read This




one character behind another, and so on. If one part refuses
to go in front of another part, try selecting the one in front
(that you want in back), selecting Restrict to Panel from the
Arrange menu, then sending it to the back.

8. Repeat steps 5, 6, and 7 until the panel is completed to your
satisfaction.

9. Choose Add Text... from the Objects menu and mess around
with words.

10. Choose Background Pattern... from the Panel menu and
mess around with patterns.

11. Choose Install Background... from the File menu, select a
file from the dialog that comes up, click OK, move the ani-
mated panel shape around in the background window, and
choose Copy to Panel from the Panel menu.

12. Admit that this is going nowhere and stop messing around.

13. Read on.

Ready to Do It the Right Way?

Good. We'll start with a little background, though not the scenic
variety. (Pages fly off the calendar as though caught in a gale, or a
really big fan, and...)

In big-time comics, since time immemorial (the 1960s), the Act of
Comic Creation has gone something like this: A Writer turns in an
outline to a Penciller who draws a layout of panels and rough art
and gives it back to a Writer who scripts dialog and captions and
gives it to an Inker who finishes the art then gives it to a Letterer
who puts all the words where they belong.

You are now all those people.

We realize that comics professionals will embrace this concept as
happily as studio musicians embraced synthesizers and manual

The Comic Strip Factory User Manual
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laborers welcomed automation. This is the price of progress. But
that’s enough creative karma to handle without the added burden
of not knowing what you're doing, as we suspect you've discovered
from your messing around.

So. To commit an act of serious comics creation, the first thing to
do is establish a:

Layout

Start fresh. If your messing around comic is still on screen, close
it and (if you want) save it. Select New... from the File menu, click
on the Comic Strip radio button in the New Document Type
dialog and click OK (or press Return). Click OK in the Initial
Layout dialog, then select Show Page... from the Edit menu.

Set initial layout [E== show Page... —=|
for this document:
o1
New Document Type: Q2
@® Comic Strip o3
Orarts
O Tent oK | ®4
O1 ®2 O3 014
@ Tall O wide O HyperCard
((cancet ) [[ ok |

You're now looking at the standard eight-panel page layout,
foundation of the modern comic book. (Remove the bottom four
panels, and you are looking at a standard four-panel comic strip
layout, foundation of the foundation. Remove all panels but one
and you’ll have a one-panel editorial cartoon layout, first
developed hundreds of years ago, completing the foundation
trilogy. Sorry.)

The panels are your camera. They're how you shoot and edit.
Adjust the panels to the rhythms of your story— larger panels for
panoramic scenes or panels with lots of exposition and dialog;
thinner, narrow panels to pick up the pace, like quick jump-cuts
in film. Jagged panels poke into each other, locked in eternal

Layout
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struggle, symbolizing chaos, opposing opposites, modern cultural
anomie, '57 Cadillacs... you get the picture.

It’s possible to modify the overall panel layout in the dialog box
that comes up when you first create a new comic. Clicking in the
numbered radio buttons will change the number of rows and
columns of panels on the page. The Tall, Wide, and HyperCard
buttons control the dimensions of the page. Tall is a MacPaint-
sized document; Wide is the same size set on its side. HyperCard
is the size of the original Macintosh screen, which is good for
making comics to use in HyperCard.

The diagram shown in the dialog shows how the page will look.
You can also modify the overall shape of the panels by dragging

on the “handles”— the black rectangles on the corners and sides of

the page rectangle. When you've got a page layout you like, click
OK to dismiss the dialog.

For more extensive panel modification, use the commands Add
Rectangle, Add Oval, and Add Triangle in the Panel menu. Or
click on one of the three leftmost icons on the icon bar, which
correspond to Add Rectangle, Add Oval, and Add Triangle.

Panel menu Objects menu Arrange menu
EBEaAR%Es ke lRR

Add Rectangle Add/Edit Text Bring to Front
@ Add Oval Edit Bits/Create Part Send to Back
@ Add Triangle €% | Duplicate
: I Background Pattern Invert
%"ﬁ Copy to Panel Flip Horizontal
Flip Dertical
Rotate

While we're on the subject of icons and menus: from now on,
when we mention a command, we’ll use its menu item name, and
tell you which menu it’'s on. Some commands have both a menu
item and an icon in the icon bar. For these, we’ll show the icon in
the margin. Whenever you choose an item from the program’s

The Comic Strip Factory User Manual

LLELR

dads

" /

” ~

v i By Ay Ay Ay

[ |

22550 L L0

@

flogeaecgegggegeea:



JUJJI IV ddddddddddd

ey
v

Tl

¢

menu, its corresponding icon (if there is one) blinks. This helps
you learn which menu items are duplicated as icons.

An important note: The icon bar doesn’t contain additional
commmands. Every icon has a corresponding menu item. The icon
bar exists only for your convenience; a quick way to issue
commands with a single click.

Back to the program. The most important thing to remember in
panel reshaping is that shapes are added to the current panel’s
shape. When you add a shape, the added shape outside the
current panel becomes part of the panel’s new boundary. Adjacent
panels are modified to fit the reshaped panel like pieces of a
jigsaw puzzle.

Try it. With an empty layout of panels, select the upper left panel.
(The selected panel is indicated by-a gray outline.) When you click
inside the panel, it will highlight. Now choose Add Oval from the
Panel menu. An animated outline of an oval appears inside the
panel. Grab the outline by the “handle” in its center: put the
cursor over the black box in the oval’'s center and hold down the
mouse button. Now drag the handle halfway between the current
panel and the next panel. Now click the OK button in the icon
bar. See what happens?

Untitled =—F—F"—

Shape is added &
to selected
panel...
...and
subtracted
from others.

It's possible to return a panel to its original shape by selecting
each of the panels that border on it in turn, choosing Add
Rectangle, then clicking OK. If you've made extensive changes to
the panel, you may have to do the same thing to the panel itself,
and you may also have to adjust the size of the rectangles you're

“adding.

Layout




If you hold down the Command key (the key to the left of the
space bar with the cloverleaf symbol) while you click OK, the
shape will be added to the layout as a separate panel. This allows
you to make rows with more than the default number of panels or
to create inset panels. With practice you can achieve many
interesting panel effects.

[ECJ=—=—= Untitled

Background files in The Comic Strip Factory are a special
treatment of MacPaint files. Only one background file can be used
with a comic strip file. You can install a background by choosing
Install Background... in the File menu. Select which file you
want as a background (any MacPaint file will do, but we've
provided special backgrounds). You'll next get a dialog box asking
which type of background to install.

Background Dimensions:

@ Panorama (24" % 3.33")
O Wide Screen (16" ® 5")
O Portrait (8" » 10")

(Change Picture | ( Blank )

The Comic Strip Factory User Manual
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Here are the choices:

e Panorama backgrounds are formed by dividing the file into
three horizontal strips, then matching the strips end to end.
(Use this format if you’re using any of the four backgrounds
that come with The Comic Strip Factory.)

i = lln}

e Wide Screen backgrounds are similar, but are divided first into
two strips representing the top and bottom halves of a standard

e Portrait backgrounds are standard MacPaint files that haven’t
been altered.

Layout




The dialog box gives the dimensions for each type of background
file.

Note: If you create a panel that’s taller than the background type
you've chosen, a background picture in that panel will not
completely fill the panel.

We've included Panorama background files that have been
specially drawn to fit the given background dimensions. A
MacPaint file not specifically intended to be a background would
look strange in Panorama or Wide Screen dimensions; it should
instead be opened as a Portrait file.

(If you're not sure which dimensions to use, select one you think
is right, click OK, and scroll around in the background window. If
there are several discontinuities in the picture, especially places
where a floor is shown above a ceiling, the dimensions are
probably wrong. Use the Change Background... command in the
File menu and select another set of dimensions.)

When you've selected a background picture and type, click OK.
The Background window will open and come to the front. You'll
notice a selection marquee in the shape of the currently selected
panel. By holding the mouse button down while the cursor is
inside this marquee, you can drag the background around the
picture. Or, you can simply click the mouse over the area you
want enclosed; the marquee will jump to that point.

Now, selecting Copy to Panel in the Panel menu copies the
background within the marquee to the current panel, and brings
the comic window to the front.

To adjust a panel’s background, first select the panel by clicking
inside of it. Next, bring the Background window to the front by
clicking on the window’s visible edge or by selecting Background
in the Windows menu. The marquee will reappear, enclosing the
area currently serving as the panel’s background. Click or drag to
make changes as necessary, then choose Copy to Panel to copy
your change to the comic.

You may have noticed the Change Picture button in the

The Comic Strip Factory User Manual
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Background Dimensions dialog box. This enables you to change
the background you're using. Choose Change Background... from
the File menu. The dialog box will appear; click on Change
Picture. The Open dialog box appears, and you can now choose a
new background file.

Note that the background will change in every panel where you've
copied a background picture. There is no way to use two
background files in a single strip, although you can, in MacPaint
(or a compatible program), mix and match portions of our
background files to create new background files. (See the
reference section’s discussion of the Paste command for a tip on
how to paste in graphics to use as a single panel’s background.) If
you want to eliminate the background picture entirely, without
replacing it, select Change Background... and click on the Blank
button.

Meanwhile, back at the Panel menu, don’t underestimate the
value of the Background Pattern... command. Each background
file in The Comic Strip Factory is designed to show a series of
related locations and can be used to indicate a character’s
“physical progress through space.”

Heavy, huh?

However, panel after panel of near-identical, slightly shifted
realistic backgrounds are a no-no. This is something you never
see in comics (early Doonesbury excepted), not just because the
weary artist doesn’t feel like drawing the same background over
and over, but because it’s boring. While background patterns can
be used to add shading to a background picture, they can also be
used instead of actual backgrounds to break things up and
provide visual drama. Backgrounds should be selected with the
same care as your panel layout. Using the same pattern
repeatedly can be more boring than using the same picture.
Lightening or darkening with some patterns may cancel out
similar patterns in the background picture.

Tip: For subtle background effects, darken your background
picture with a light pattern, lighten it with a dark pattern.

Layout
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[ use pattern: @ as background
O to darken background

O to lighten background [ Cancel l l

The three radio buttons in the Background Pattern dialog allow
you to choose between

¢ as background, for using a pattern as the sole background in
the panel,

¢ to darken background, for using a pattern to darken the
currently installed background picture, or

¢ to lighten background, for using a pattern to lighten the
background picture.

Or, you can use the background picture without modification by
unchecking the Use pattern checkbox. The pattern palette works
like it does in MacPaint. click on the desired pattern, and the
pattern you select appears in the larger box to the left. Click
Cancel to change your mind and OK to put the desired change
into effect.

Select a panel in which you've copied a background picture, then
choose Background Pattern.... With Use pattern checked, click
in the seventh pattern on the bottom row. Notice that the large
square on the left fills with the pattern, indicating that it’s
selected. Make certain that the as background radio button is
selected, and then click OK.

Now select or create another panel with a background picture in
it. Choose Background Pattern... again, and click on the to
darken background radio button. Do the same, with yet another

panel, but selecting to lighten background. Select another panel,

choose Background Pattern one last time, uncheck the box next
to Use pattern, and click OK. Compare your results in the
different panels.

The Comic Strip Factory User Manual
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Experiment with this feature to see the many effects possible.

Untitled

To eliminate a background (picture and pattern) from an
individual panel, choose Background Pattern... from the Panel
menu. From the dialog, choose the blank (white) pattern as the
background; this eliminates the previous background.

Balloons, Captions, & Scripts

There are two ways to enter text for balloons and captions.
Following the classic model outlined under Ready to Do It the
Right Way?, you could prepare an entire script ahead of time in
The Comic Strip Factory Text Window or any word processor that
saves text-only files. You can also use a text editor disk accessory
like CE Software’s MockWrite or SideKick’s NotePad+.

Choosing Open... in the File menu of The Comic Strip Factory and
clicking on the Text radio button in the Open dialog lets you open
a text file to copy dialog between it and the balloon editor. You can
also create a new script by choosing the New... item in the File
menu and clicking the Text radio button in the New Document

Balloons, Captions, & Scripts




Type dialog. Or, you can enter and edit all text in the balloon
editor itself.

7277

L/

There’s an advantage to writing your scripts beforehand. You can
then start on a page of empty panels, create all your dialog
balloons, and place them roughly where you want them on the
page. This way, you’ll know whether the script needs padding to
fill out the page (or larger panels or a smaller page) or whether
dialog needs to be cut to make room for pictures. If you'’re making
a multiple page comic book, you can make sure punch lines are
strategically placed to keep readers turning pages. The Cornic Strip
Factory doesn’t force you to work this way, but you may find that
work proceeds faster if you first “lay down the dialog,” then add,
remove, and reshape balloons to fit the pace of the action, then
put the characters in place.

L/

f <

17999777

1775

But dialog balloons are more than just letters, spaces, and
punctuation. The format of each balloon, and the style changes in
the balloon, are important to the look of the comic strip. To
establish these elements, you have to take your text from the
simple lines-and-paragraphs environment of the Text window into
the balloon editor.

179

" & File Edit Panel

S

A IATTER
TRANSPORTER?” I SAD,
“HOW GOOD COULD THAT
BE?” “WHO CARES" HE
SAID, “IT'S ON SALES”
“WELL SOREITIS,” I SAD...|

2L

'

VAN AR

'

(cut ) copy ][ Paste ] st
@] EIE=] [seach ot ||| _Pain_(Underiine)
Bookman [ Bold ][ Outline ]
(Csetfant ] ]

1talic ](_ Shadow

«

q

o AR

@ For a guided tour of the balloon editor, Choose Add Text... from
the Parts menu. You’'ll see the balloon editor take over the screen
and activate the icon bar’s OK and Cancel buttons. On the left of
the screen under the icon bar is the text entry area, with a cursor,
scroll bar, and a grow box (under the scroll bar). The grow box

The Comic Strip Factory User Manual
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makes the text area narrower or wider. Drag the grow box as you
would the grow box of any standard window.

[ Cut ][ Cong[ PasteJ

Below the text area are three buttons: Cut, Copy, and Paste.
These behave just like Cut, Copy, and Paste commands in the
Edit menus of most Macintosh word processors and text editors.

H d

Immediately below and to the left of the Edit buttons are three
icons that control the thickness of balloon lines. The far left icon
makes the balloon outline invisible. The center icon gives the
balloon a one-pixel wide outline; the far right icon makes the
balloon outline two pixels wide. (A pixelis a single dot on the

screen: about 1/72”.
===

To the right of the “line” icons are three icons to control text
justification. The first icon sets “flush-left”: text that’s even on the
left margin, but varied on the right margin, like a page typed on a
typewriter. The manual you're reading is set flush-left. The second
icon sets centered text— the default setting. The third icon sets
text “flush-right”; the opposite of flush-left.

= RREEEE

Underneath these icons, at the bottom left, are a row of icons to
select the balloon type. The balloon types range from bumpy
“thought” balloons to a plain rectangle, useful for captions and
exposition. Any balloon type can be given a “pointer,” but we're
getting ahead of ourselves. Click any of the balloon icons to select
a balloon type.

Beach & (9 J(10)(12])(14)
Beach Bold [ 18 )( 20 )( 24 )( 36 )

Beach Empha - <
Beach Italic (__ Plain__]( Underline ]

Bookman 5| Bold ) Outline )
( setfent ] [ Italic ][ Shadow ]
To the right of the balloon icons is a Fonts list and a group of

buttons to control text size and style. Select a font by clicking its
name (use the scroll bar to find the right one if necessary), then

Balloons, Captions, & Scripts
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clicking the Set Font button (or just double-click the font name).
Text entered after clicking Set Font will be displayed in the
selected font. To change some or all the text you've already
entered, select the text then change the font. This is done as in
MacWrite: click and drag over a range of text or double-click to
select an individual word. First select, then change.

The same is true for size and style changes, which are done with
the buttons to the right of the Font list.

When you've finished with the changes and additions for your
balloon, click the OK button in the icon bar. Or click Cancel and
return to the comic window without making changes.

Tip: When putting words into a comic strip, don’t describe what
your pictures are showing. Dialog in comics is for communication
between characters; captions are for exposition and narrative. The
use of boldface or other style, or even a different font, on selected
words keeps your characters from speaking in a monotone.
Watch a television newscast and listen to the way the
anchorpeople talk. That vocal rise and fall and emphasis on
every seventh word is something they learn in famous
broadcaster’s school. It keeps your attention. But don’t overdo it.

Let’s try it out. Start from scratch: back in the main program
screen with just a Comic window open. Choose New... from the
File menu and select the Text document type. Type “This is a
test.” Now select the text and choose Copy to Panel from the
Panel menu. The balloon editor window appears with “This is a
test.” centered on the top line of the text area. Select the entire
sentence, click the Copy button, then click Paste three times.

Experiment with the size box in the lower right corner of the text
area. Grab it and move it back and forth; notice the effect on text
in the window. Try out the flush right and flush left icons,
immediately under the Paste button.

Now double-click on the third “test” to select it; it will be displayed
inverted. Next click Chicago in the scrolling Font list at the
screen’s bottom and click the Set Font button. Select the last “is”
in the text and click the Italic button. Finally, move the cursor to
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the end of the text, set the font to Monaco, click the 9 button for
nine-point type and type “end of test.” Now select a balloon type,
and make sure it has a visible outline. Click the OK button in the
icon bar.

The balloon will appear in the current panel, with a selection
marquee around it. To give a selected balloon a pointer, choose
Point Balloon from the Objects menu. A special point-balloon
cursor will appear, along with an outline of the pointer. Notice
that the balloon pointer always starts from the center of the
balloon. Move the cursor around until the pointer “points” where
you wish, then click the mouse button. (Note: you can Cancel
Point Balloon without adding a pointer by clicking on the balloon
or outside the window).

“A 'CHONK STYLE
MATTER TRANSPORTER?”
1 SAID, “HOW GOOD
COULD THATBER"
“WHO CARES"™ HE SAID,
“IT'S ON S ALE/”" “WELL

SOREITIS,” I SAD...

Additional pointers can be added by selecting the balloon and
choosing Point Balloon again. You can remove all pointers or
change a balloon entirely by selecting it, then choosing Edit
Text... in the Objects menu. The balloon editor will appear again
with the text and current settings in place. Change these as
needed or desired. Or click OK without making any changes to
eliminate all pointers. Easy, huh?

Point Balloon can only make straight pointers. If you want to
have thought bubbles coming down from thought balloons, or if
you want curvy or jagged pointers, a sampling of such is available
in the parts file “Bubbles & Pointers.” It’s also very easy to make
your own bubbles and pointers with the Create Part... command
in the Objects menu. Or use MacPaint and import the results with
PartMaker II or the Scrapbook desk accessory.

Balloons, Captions, & Scripts




Words & Characters

Even if you're an accomplished computer comic artist, The Comnic
Strip Factory is invaluable as a framework tool, and for the ease of
layout and lettering it provides.

But maybe you're not a accomplished computer comic artist, and
bought The Comic Strip Factory to give your literary instincts a
better showcase than your artistic abilities, alone, provide. If so,
you'’re limited to the Parts files that came with The Comic Strip
Factory, Comic People volumes, and commercially available clip
art, to vent your urge to self-expression.

Fortunately, it’s not limiting, because any MacPaint-based image
can be used by The Comic Strip Factory (see the “Rolling Your Own
Parts” section for details). But this program presupposes that you
have a tale worth the telling and the ability to tell it. We can’t
supply computer-generated plots or a sense of humor (yet). And
the telling is a matter of taste and inspiration. As you start
putting the pictures in panels, they may suggest things to you
that change your story. The characters may overwhelm the story
and take everything somewhere else. You may decide you don’t
need words and can tell it in mime. There’s just no way of
knowing: This is New Stuff. Let it happen. Have fun. Be happy.

Customizing & Cleaning Up

The fine points of parts and balloons can be cleaned up using the
Edit Bits... command in the Objects menu. The Edit Bits...
command lets you modify both the comic object and object’s
“background mask.”

Think of the background mask as a small sheet of paper where
the object is drawn. The mask blocks anything behind it from
showing through. To make a convincing doughnut, you’d make
sure the background mask didn'’t cover the hole. That way, the
background would show through the hole.

The Comic Strip Factory User Manual
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Here’s how to do it. Select an object and choose Edit Bits... from
the Objects menu. On the window’s left you’ll see four MacPaint-
style tools. These function as in MacPaint. the hand moves the
image around, the pencil changes (draws or erases) single pixels,
the paint brush paints a larger area, and the eraser erases.

o
il

Below these tools, though, are two additional selections. These
determine which pixels can be edited. With the top button
selected, you’ll be editing the white background mask pixels. The
bottom button lets you edit black pixels of an object. The gray
area represents the background behind the transparent part.

[Note that black pixels can only be drawn on the background
mask. If you want to “add on” to a part or a balloon, you'll have to
draw the mask area first. This needn’t be precise, and you can
erase unneeded mask bits after you've drawn the black bits. But
be sure to leave a border around an object, about one pixel wide,
so it stands out from the background. And it’s good to erase the
border where a part touches another part— where the head and

torso join, for example.

Customizing & Cleaning Up



There’s a regular-size image of the object at the upper left to guide
you as you work. The image will change to mimic your Edit Bits
changes. Click Cancel to throw out changes you've made, or OK if
everything’s cool and you want the changes incorporated.

Note: Edit Bits... can also be used to edit balloon pointers, and to
give balloons nifty special effects like “icicles.” You can edit only
the outline of a regular balloon. To edit the black bits, choose
MergeBits in the Objects menu. MergeBits converts a balloon
into a part. The text inside the balloon can no longer be edited,
however, nor can the balloon be changed further except with Edit
Bits.... MergeBits gains you access to the black bits of Edit
Bits... at the expense of “freezing” your balloon text. Experiment
to determine when to “merge” and when not to “merge.”

Rolling Your Own Parts

We've provided you with a raft of ready-drawn art, but you’ll
probably want to import your own graphic creations, or use
graphics from other packages and programs. At the simplest level,
art can be copied to the Clipboard or Scrapbook then pasted into
an existing or new parts file, or directly into a comic strip. The
object can then be cleaned up in Edit Bits....

MultiFinder is great in these instances. With it, you can run both
The Comic Strip Factory and MacPaint (or another paint program)
together. Then you can draw objects as needed and quickly move
them to The Comic Strip Factory. The Comic Strip Factory requires
at least 320K of memory with MultiFinder, and is happier with
512K or more.

There are a number of graphic desk-accessory tools that you can
use with The Comic Strip Factory. These provide varying degrees of
power, ranging from Art Grabber, which just allows you to Copy
and Paste rectangular areas, to DeskPaint and Canvas, with a full
range of painting features. Any of them are useful in a pinch.

PartMaker II
We've also provided a utility program, PartMaker II, that works
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with standard MacPaint files. PartMaker II:

¢ reads MacPaint files,

e converts MacPaint graphics into parts, and

e saves the parts for use in The Comic Strip Factory.

How it Works

PartMaker II “sees” a paint file as blobs of black dots separated by
white space. The blobs are converted to parts and copied to a
parts file, which you can then name and save.

Before we discuss how it’s done, let’s define “paint file” and “white
space.”

A paint file is any file MacPaint can open. But the file needn’t be
created by MacPaint. FullPaint, SuperPaint, MacBillboard,
GraphicWorks, The Comic Strip Factory, and most graphic
digitizers can save MacPaint files. Some of these products save
paint files as an option. Others, like MacBillboard and FullPaint,
use paint files exclusively.

Most clip art comes in paint files. Clip art is ideal for parts files
because clip art objects are surrounded by generous white space.

The white space is important. To PartMaker II, white space is

“space separating distinct objects.” That definition is used by
PartMaker II to find graphic objects and to create parts.

A paint file is scanned until a black dot is found. The object’s edge
is then traced. The edge is where white dots meet black dots. To
PartMaker II, everything within the edge is an object.

So far, PartMaker II is like an automatic MacPaint “lasso.”

Many comic parts, however, aren’'t tightly enclosed. Fred Nerd and
Root Wiz, for example, have wispy hair— potentially many, many
separate objects!

To include those stray bits, PartMaker II looks at neighboring

Rolling Your Own Parts ,




parts. If a neighboring part is only one white dot away, the two
parts are merged together.

When designing your own parts, remember that “white space”
means “separated by more than one white dot.”

Using PartMaker II is simple. Just run the program, choose
Convert Paint from the PartMaker 2.0 menu, select a paint file
you want to make into parts, and click the Open button. When it’s
done, give the new file a name (or accept the default of the old
name plus “.parts”) and click the Save button. Now you’re ready
to open the new parts file from The Comic Strip Factory.

PartMaker 2.0

Cnnuertlng paint file “Oliver McCloud Paint” into comic parts...

LI EAT
99!! !@Q

iR
# PARTMAKEQQ !!!!”S

Cowrm( ©1987, Foundation Pubhshmq Inc. All rights reserved.

You may find, though, that wisps of hair or whatever are wispier
than PartMaker II takes into account. Remember, if stray dots are
separated by more than one white dot, PartMaker II makes them
separate objects. To merge these “strays” manually, load the new
parts file into The Comic Strip Factory. Then drag a selection
rectangle around objects that may be several parts. If two or more
animated marquees appear, select MergeBits from the Objects
menu. The MergeBits command “merges” the separate parts into
one object.

You may also find objects that aren’t completely enclosed. White
sections of these parts may become transparent. To find the
transparent areas, use Background Pattern in the Panel menu to
put a gray background in the Parts window. To fix partially
transparent parts, use Edit Bits....
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“Character Assembly”
OR
Motd Me Closer, Tawny Dancer

TAWNY DANCER
EXPLAINS IT ALL
FOR You!?

DAVID

BY ANDY,
TRICI, AND

HiYA! AS THE MOST
COMPLEX AND
ANATOMICALLY
CORRECT FIGURE IN
THE COMIC STRIP
FACTQRY AT THE
MOMENT, THE GUYS
THOUGHT IT WQULD Be
NEAT If | EXPLAINED A
FEW THINGS ABOUT
PUTTING BODY
PARTS TOGETHER..

"

e
! THOUGHT IT SOUNDED KINDA |
YUCKY WHEN THEY PUTIT  °©
THAT WAY, BUT THEN THEY
SAID | COULD USE MY OWN
BODY TO SHOW YOU HOW,  [37¢
AND | SAID "NEAT!™ | THINK A [
PERSON SHOULD TAKE EVERY |
QPPORTUNITY TQ USE THE
GIFTS THEY'RE BORN WITH TQ
PERSONALLY EDUCATE
QTHERS, DON'T YOU?

S

HERE'S ME \WTH TWO

ALSQ, ! GOT 7O DA
LQT7S OF SILLY
STUFF, LIKE THIS..

RIGHT FEET.! SURE
COULDNT DO MUCH
DANCING LIKE THIS!
THAT'S WHY | ALWAYS
MAKE SURE BOTH BIG
TOES ARE TOWARD THE
CENTER Of MY 8BODY.
UNLESS I'VE GOT MY
LEGS CRQSSED,
NATCH!

X ST

COMPARE IT TQ MY OUTER THIGH.

ATTACH MY LEGS SO
THAT THE TOP EDGES
MEET. THINK OF A
"¥" NECK SWEATER.

WRANG!

>

WRONG!

i@

HERE WE SEE MY INNER THIGH. SEE HOW
THE "¥" STRIPE POINTS TO THE KNEE?
KNEW THESE WOULD COME IN HANDY!

GAWD, | SWEAR | AM SUCH A TUBY

Inner thigh Outer thigh

{0+

POP QUIZ:

IS THIS HER LEFT FQQT
OR HER RIGHT FOQT?

_ QVstripe

ANSWER:
-
Big toe  ¥4bKY

i

”..
ARMS ARE GREAT. || JUST SO YOU KNOW, THOUGH,
THE BACKS OF MY HANDS
| HAVE "¥" SHAPES ON EM! MY

PALMS ARE BLACK!

|

DONTCHA LOVE
'EM? THE RADIUS
BONES CAN TWIST E

ARQUND EACH

QTHER SO THE
PALMS OF YOUR
HANDS CAN BE

FACING FRONT b -
OR BACK, NO ‘w

MATTER WHICH
WAY YOURE FACE
IS FACING.

Character Assembly




ON THE INSIDE OF MY
UPPER ARMS, THE "Y'
STRIPES POINT DOWN,
TOWARD MY ELBOW.

POINT UP, TOWARD MY
SHOULDER!

[ON THE QUTSIDE, THEY LB

THUMBS ARE LIKE BIG

TOES (REMEMBER?): PALM |
§ UP, THUMB OUTSIDE; PALM |

DOWN, THUMB INSIDE!

T ey Ly s o e T T T e 7 7 X iy o o e AR
e [ e
I
e
e
s
G
et

FOR THE TWISTY
STUFF, USE YOUR

| OWN ARM AND

| HAND AS A MODEL!

N rd

o .
WHEN YOURE STICKING MY
ARMS ON MY BODY, THEY
SHOULD JOIN RIGHT AT MY
SHOULDERS. If THERES A
STRAY PIXEL OR TWQO
AFTERWARDS, JUST SMOQTH
T QUT WITH EDITBITS!

A

ON FORESHORTENED OR TILTED BODIES OR

HEADS, LINE UP THE CENTER-POINT OF MY
NECK STRIPE \W/ITH THE CENTER POINT OF MY
b, CLAVICLE STRIPE. If EITHER OF THEM DOESN'T
SHOW, JUST OVERLAP MY NECK STRIPE WITH
MY BODY STRIPE! (TICKLES!)

WANNA HELP ME GET MY HEAD
TAGETHER? JUST STICK THE
BOTTOM OF MY RECK ON MY BODY!

ALL TOGETHER WO\
START WITH MY TORSO.

~THEN MY ARMS AND
LEGS. DONT TRY TQ
JOIN UP MY LEGS FIRST!

™ <

The Comic Strip Factory User Manual

HOW DO ! LOOK? KINDA
WEIRD! CHECK A MIERAR
AND SEE If YOU CAN
TAKE THE SAME
POSITION! NO? THEN !
BETTER TELL YOU ABQUT:

Contrapasto!
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WHAT IT REALLY MEANS
. Contrap astol! IS "HOW TQ STAND LIKE A
| THE BUG TOOK ME TO AN ITALIAN GREEK STATUE" OR
| RESTAURANT ONCE AND | PIGGED SOMETHING.MITH ALL
1 OUT ON THIS STUfF. Ha=HA? THE ANGLES Of THE
BODY OPPQOSITE ALL THE

OTHER ANGLES!

NOW TRY TQ
SLANT YOUR
SHOULDERS

IT'S THE RIGHT WAY 70 |
STAND, ANYWAY. THE %
SHOULDER SLANT IS
ALWAYS OPPQSITE THE HIP THE SAME
SLANT. If YOU DON'T WAY AS YO}(R
BELIEVE ME, STAND WITH HIP. 1CKQ?
YOUR WEIGHT ON ONE
LEG AND LOOK IN A
FULL-LENGTH MIRROR! |

¢ N

A, THE HIGH HIP a

¢ SUPPORTS THE =+ Y04
WEIGHT. THE FOOT

ATTACHED TO THE
LEG ATTACHED TQ
THAT HiP SHOULD
B8 UNDER THE
CROTCH!

YOU SHOULD HAVE AS
MANY TORSQS AS YOU
NEED FOR THIS BUT
YQU CAN HELP BY
ASSEMBLING ONE ARM
SLIGHTLY RIGHER THAN
THE OTHER. THAT'S WHY
MY SHOULDERS ARE
BUILT INTO MY ARMS!
NEATO!

DID | MENTION FATBITS? WELL | WASN'T
TALKING ABOUT MY CELLULITE, BUSTER.
NONE OF US HERE IN C.8.F. WOULD THINK
OF TRYING TQ GET ALONG WITHOUT THESE
LITTLE PIXEL PALS.

THEY'RE ACTUALLY
CALLED EDITBITS IN

1 THIS PROGRAM. ON THE
NEXT PAGE, MY LITTLE
BUDDY THE NERD \WiLL
SHOW YU WHAT YOU

CAN DQ WITH THEM!

Character Assembly




HI! WE BILL C.8.F. AS A
GRAPHICS PROGRAM
YOU DON'T NEED TQ BE
AN ARTIST TO USE.
NEVERTHELESS, THERE
ARE SOME SIMPLE
THINGS YOU CAN DO IN
EDITBITS THAT CAN
EXTEND THE ARTWORK
WE'VE SUPPLIED!

JUST BY MOVING
THE PUPILS OF
THE EYES AND
ERASING PART OF
THE CHEEK LINE,
I'VE UNDERGONE A
SUBTLE CHANGE
OF EXPRESSION!

The Comic Strip Factory User Manual
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mid

SOME LESS SUBTLE
CHANGES, LIKE
ERASING THE WHOLE
SMILE LINE AND
ADDING SHADING TQ
THE NOSE, MAKE ME

- LOOK LIKE A
DIFFERENT GUY!

A LOT LESS
HANDSOME, !
MIGHT ADD!

TAKE A FACE
THATS ANGRY...

Character Assembly
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DISCOMBOBULATE

THE EYES, AND PLAY
WITH THE MOUTH A

LITTLE, AND IT LQOKS
LIKE IT'S BEEN HIT ON
THE HEAD!

W I N AN N N T O A N T O A

')

PLAY WITH THE MOUTH
SOME MORE, AND YQU CAN
EVEN GET A NIFTY
EXPRESSION OF DISTASTE!

The Comic Strip Factory User Manual
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PROGRAMMER, NOT

8Y AN ARTIST, 50

DON'T BE AFRAID
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Introduction

The Comic Strip Factory provides all the tools you need to create
comic strips. The comic strip can be created using artwork
supplied with The Comic Strip Factory or graphics created in
MacPaint and compatible graphics programs. Like MacPaint, The
Comnic Strip Factory creates single-page documents. Multiple page
comic strips require multiple comic files.

The Comic Strip Factory is a little like MacDraw in that it allows
you to manipulate parts of the document on the screen as if they
were individual objects. Think of these objects as pieces of paper
on which elements of the document are drawn: the pieces of paper
can then be shuffled around to construct a pleasing whole.

This contrasts with the MacPaint “bitmapped” approach, in which
the document emulates a piece of paper or a canvas you can paint
on. Unlike MacDraw, however, the objects that The Comic Strip
Factory can manipulate are not lines and circles and rectangles,
but pieces cut from a MacPaint canvas. Special tools in The Comic
Strip Factory for working with these bitmapped objects— or Parts,
as we call them— and other special objects optimize the program
for making comics.

Roadmap

This Introduction to the reference section of the manual provides

Introduction




a conceptual overview to The Comic Strip Factory, introducing the
terms and ideas used elsewhere. The following two sections,
Windows, Keys, and Mouse Actions and Menu and Icon
Commands, will give you the meat and potatoes of how to use the
program. Using PartMaker II gives you to lowdown on The Comic
Strip Factory’s accompanying utility program for converting
MacPaint files into Parts files. The final reference section,
Keyboard Shortcuts & Extensions, is a listing of features that
make the program faster and more powerful for the experienced
user.

Objects and Panels
The Comic Strip Factory uses graphic objects which are placed in,

and in front of, panels. Objects that overlap the panel boundaries
are said to be freed from panels.

ALL THESE PICTORES OF
ME ARE RESTRICTED TO
PANELS, BOT THIS
DIALOG BALLOON IS
FREEDFROM PANELSY!

Panels are shapes where objects and backgrounds usually appear.

Panel arrangement defines the structure and flow of the comic
strip. When a comic page is created, it contains rectangular
panels, all the same size. Existing panels can be customized by
adding resizeable rectangles, ovals, and triangles to panels. And
new panels can be created from these three editable shapes. An
area of the page may be covered by a panel or be empty, but it
can’'t be covered by more than one panel. Since panels don’t
overlap, when you add a shape to one panel, you usually also

The Comic Strip Factory User Manual
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subtract part of that shape from one or more neighboring panels.

Each panel may be given a background picture and a background
pattern.

There are four types of objects. The first are parts. Parts are small
pictures that are usually pieces of comic characters— heads,
bodies, arms, legs, hands, feet, and so on— that can be put
together in combinations to populate a comic strip. Parts are
supplied with The Comic Strip Factory in parts files.

We sell additional parts disks with more comic characters under
the name Comic People. The first volume, Office Days, is already
available; sample art from it appears elsewhere in this manual.
(Send in your registration card, and we’ll let you know about new
offerings by flooding you with junk maill) There are also tools to
create new parts files from MacPaint artwork. A tool similar to
MacPaint’s FatBits (we call it Edit Bits) allows you to customize
parts.

It was a dark and
stormy night...

I THINK,
THEREFORE
LAMAY

Hithere,
handsome!

The second object type is the text object. Text objects include
seven different kinds of dialog and thought balloons and narrative

Objects and Panels




boxes. Text in balloons can vary by font, style, and size. Text
objects are created with a balloon editor that has editing features
similar to a word processor’s. Text can be typed into the balloon
editor or copied from text-only files created by most Macintosh
word processors and text editors. There is also a simple text editor
built into The Comic Strip Factory. Once a balloon is created,
pointers can be added to indicate the speaker or speakers. The
balloon shape can be customized with Edit Bits.

The third object type is the silhouette. Silhouettes are shadows of
other objects. They are unique to The Comic Strip Factory.
Silhouettes are created black, but can be changed to a pattern,
and they can be painted over the background and objects they
cover; or they can be semitransparent, lightening or darkening the
background. The silhouette shape can be edited with The Comic
Strip Factory's by-now famous Edit Bits command.

The final object type is the group. A group is a collection of objects
of any type, including other groups. Group is a convenience
feature: once you've assembled parts, silhouettes, and text
balloons, you can group them. Grouping makes many objects
behave as a single object, making it easier to move and copy the
group intact.

Grouping isn’t permanent: To change the head on a character that

The Comic Strip Factory User Manual
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you've grouped, for example, you can easily ungroup the
character, delete the old head, put in the new one, and group it
again.

The Icon Bar

The Comic Strip Factory includes another convenience: the Icon
Bar.

Feji{Fe ) F7 g ENEIE @ B

Under the menu bar is a white strip containing fourteen icons.
The icons duplicate frequently used menu commands. Since The
Comic Strip Factory is primarily a mouse-driven program, the icons
provide a fast and easy mouse shortcut to menu commands. Some
menu commands also have command key equivalents, especially
those commands common to other programs. When a command is
unavailable, both its menu item and its icon dim.

On the right-hand side of the icon bar is a white space. When the
program is in certain special modes, such as the balloon editor,
Edit Bits, and Show Page, two buttons appear here: OK and
Cancel. These buttons are used to exit those modes.

Windows

There are four types of The Comic Strip Factory windows. First and
most important is the Comic window. This is where a comic
document is edited. A Comic window is opened by choosing New...
or Open... from the File menu and clicking the Comic Strip radio
button in the resulting dialog.

Second is the Background window. This holds the background
picture associated with the currently opened comic file. A
background picture is loaded from a MacPaint file with the Install
Background command in the File menu.

The Background window treats a MacPaint file in one of three
ways: 8" by 10" Portrait (the normal MacPaint orientation), 16" by
5" Wide Screen, or 24" by 3 1/3" Panorama.

The lcon Bar




Install Background... creates Wide Screens and Panoramas by
dividing the portrait into two or three horizontal strips, then
reassembling them next to each other. Four background pictures
are provided with The Comic Strip Factory, and you can use any
MacPaint file as a background as well. Once installed, the
background picture can be changed or blanked out with the
Change Background... item in the File menu, which replaces
Install Background... when a background is installed.

The third window is the Text window. This is a basic text editor
that can be used to write comic strip scripts. Scripts can also be
written in MacWrite, Microsoft Word and other programs that save
text-only files. Text in the Text window can be selected with the
mouse and brought into the balloon editor to be transformed into
text objects.

The Text window is opened by choosing the New... or Open...
command from the File menu and clicking the Text radio button
in the resulting dialog.

The fourth window is the Parts window. The Parts window is
where parts files supplied with The Comic Strip Factory are loaded,
and where new parts files are created. Parts can be created by
pasting graphics into this window from MacPaint and other
graphics programs. Parts can be moved into the Comic window
using the usual Edit menu features, or using Copy to Panel, a
special, faster copying feature of The Comic Strip Factory.

The Parts window is opened with the New... or Open... command
in the File menu and the Parts radio button in the resulting
dialog.

Windows, Keys, and Mouse Actions

All four windows behave like windows in most other Macintosh
programs. Clicking on a window behind another window brings
the rear window to the front. Dragging the title bar moves the
window; dragging the grow box (in the lower right corner) resizes
the window. Scroll bars scroll in expected ways (refer to your
Macintosh user’s manual if you're not familiar with the Macintosh

The Comic Strip Factory User Manual
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user interface).

The Comic Window

contains the comic document. It consists of panels and areas not
bounded by panels. There must always be at least one panel in a
Comic window. There is always one panel selected, and up to
thirty-two objects may be selected as well. Most editing actions act
on the selected objects and the current panel. The current panel is
outlined with a gray border, and the selected objects are
surrounded with animated rectangular marquees.

Comis lla
-

DON'T WANT TO STEAL

ANYTHING, | JOST WANT g
g TO TAONT HIM WITH THE [
H FACT THAT I'M A BETTER [, )
 _ HACKER THAN HE |

Pressing the Tab key scrolls the window to the current panel if it is
not entirely visible in the window.

Objects are selected in the Comic window as icons are selected in
the Finder, with the following restrictions and limitations. Only
thirty-two objects can be selected at once. These may include both
objects restricted to the current panel and objects freed from panel
boundaries. The selection may not include objects that are
restricted to other panels. An object is shown to be selected by an
animated marquee rectangle around it.

Clicking on an object selects it. If the Shift key is held down,
previously selected objects remain selected; otherwise, clicking
deselects previously selected objects. Clicking on a point where
there is no object, without holding down the Shift key, deselects

The Comic Window
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all objects. Shift clicking on a selected object deselects that object
without deselecting other selected objects.

Clicking in a panel other than the selected one, except to select a
freed object, selects the new panel as the current panel and
deselects all selected objects.

The availability of menu items depends on what object or objects
are selected. Most menu actions are performed on selected objects.

Clicking on an area where there is no object and dragging
stretches a selection rectangle. When the mouse it released,
objects inside or overlapping the rectangle are selected. If the Shift
key is down, the new selections are added to objects already
selected.

Clicking on a selected object and dragging moves that object and
other selected objects when the mouse is released. If the mouse
cursor enters a panel other than the selected one while objects are
being dragged, the newly entered panel is selected. Any restricted
objects are dropped into the panel that is selected when the mouse
is released, unless they don’t overlap it, in which case they are
freed from panel boundaries.

Dragging objects beyond the Comic window’s edge causes the
window to “auto-scroll” in that direction.

Holding down the Option key while clicking on and dragging
objects moves copies of the objects, leaving the originals where
they were.

Holding down the Command key while clicking on and dragging
objects restricts movement to the vertical or horizontal axis,
depending on which direction the mouse is first moved.

Pressing the Backspace key deletes all selected objects.

The Background Window

contains the background picture, which is actually stored as part
of the comic document. When the Background window is brought
to the front, it displays an animated outline representing the

The Comic Strip Factory User Manual
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current panel in the Comic window. The location of this outline
(along with settings in the Background Pattern dialog) determines
the background picture displayed in the panel.

Background

The background picture of the selected panel may be changed by
dragging the animated panel shape to another location on the
background picture. If the distance you want to move the shape is
larger than the window, you can scroll to the desired destination
and click the mouse to “snap” the shape to the new point. Or, if
you drag the shape off the edge of the window, the window will
auto-scroll in that direction.

The part of the background picture surrounded by the animated
shape is copied to the panel by the Copy to Panel command in
the Panel menu. This also brings the Comic window to the front.
Any other method of bringing another window to the front leaves
the background of the panel unchanged.

The Text Window
contains a text-only document which may have been created in
The Comic Strip Factory or a word processor or text editor.

Clicking the mouse in the text places an insertion point; clicking
and dragging selects a range of text. Typing while a selection is
displayed deletes the selected text and replaces the selection with
an insertion point. Typing while there is an insertion point inserts

The Text Window




the characters typed at the insertion point.

1l

S=——= Ad Text =——=VF|

(CIRCULAR PANEL)
FEATURING FRED NERD!

Y oy

/AR

FRED:

I'M JUST AN ORDINARY COMPUTER GUY.
SURE, IVE TRIED MACPAINT, BUT |
CANT REALLY DO ANYTHING ON IT.

«

BUT I'VE ALWAYS LOVED COMICS. AND !
HAVE GREAT IDEAS FOR THEM! BUT, OF
CQURSE, | CAN'T DRAW A STRAIGHT
LINE WITH A RULER!

e

/AR

SQ ! GOT COMIC STRIP FACTQRY, AND O
IT'S GREAT! | DON'T HAVE TQ DRAW: |

«

Cut, Copy, and Paste in the Edit menu perform as they do in
other text edit programs. Cut deletes the selection, leaving a copy
on the Clipboard. Copy copies the selection to the Clipboard.
Paste replaces the selected text with the Clipboard contents or
inserts the Clipboard contents at the insertion point.

«

NN

Selected text is copied into the balloon editor by selecting Copy to
Panel from the Panel menu. Text can then be made into a balloon
and placed in the Comic window.

22 %

The Parts Window

contains parts that may be copied to the comic document. A parts
document is a library of parts; it usually contains a set of parts
that are used to create a single character. Some parts files may
contain props (things) or body parts for use by more than one
character. Actually, since you can create your own parts files, the
Parts window can contain whatever assortment of parts you want.

22229

OLI

Selecting objects in the Parts window works like selecting icons in
the Finder. There are fewer restrictions in the Parts window than
on selecting and manipulating parts in the Comic window because
the Parts window contains no panels. Still, only thirty-two objects
may be selected at once. An object is shown to be selected by an
animated rectangle around it.

I Ty B
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Clicking on an object selects it. If the Shift key is down, clicking
leaves previously selected objects selected; if the Shift key isn’t
down, clicking deselects previously selected objects.

Clicking where there isn’t an object, without holding the Shift key
down, deselects all objects. Shift-clicking on a selected object
deselects that object without deselecting other selected objects.

Clicking on an area where there is no object and dragging
stretches a selection rectangle. When the mouse is released,
objects inside or overlapping this rectangle are selected. If the Shift
key is down, the objects are added to the objects currently
selected.

The availability of certain menu items depends on what object or
objects are selected. Most menu actions are performed on the
selected objects.

Hitting the Backspace key deletes all selected objects.

Clicking on a selected object and dragging moves that and all other
selected objects when the mouse is released. Dragging objects off
the window auto-scrolls the window in that direction. Holding
down the Option key while clicking on and dragging objects leaves
a copy of the objects behind.

Holding down the Command key while clicking on and dragging
objects restricts the movement to the vertical or horizontal axis,

The Parts Window /—'\\
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depending on which direction the mouse is first moved.

Selected parts may be copied to the current panel of the Comic

window, bypassing the Edit menu, by selecting Copy to Panel
L from the Panel menu.

Menu and Icon Commands
Apple Menu

The Comic Strip Factory has a standard Apple menu. The first item
is About Comic Strip Factory..., where program credits are
shown. The remainder of the menu contains the desk accessories
installed in your system.

File Menu

New...

brings up the New Document Type dialog from which you can
select the kind of document— Comic Strip, Parts, or Text— to
create.

New Document Type:
@® Comic Strip

Orarts
Oten

Since The Comic Strip Factory can only have one of each kind of
document open at once, radio buttons in the dialog for types
already open are dimmed. The first available type will be
preselected. Depending on the radio button selected when you
click OK, the following will happen:

The Parts radio button creates a new parts document and opens

the Parts window. It is available only when no parts document is
open.

The Comic Strip Factory User Manual
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The Text radio button creates a new text document and opens the
Text window. It is available only when no text document is open.

The Comic Strip radio button creates a new comic document. It is
available only when no comic document is open. It brings up the
Initial Layout dialog, which allows you to establish the initial
layout of panels on the page.

Set initial layout
for this document:

o1
Q2
b
QO3
® 4
i
O1 ®2 O3 OA

@ Tall O Wide O HyperCard

You can create a layout that consists of up to four rows of panels
and up to four panels in each row. The panels will be rectangles of
equal size and shape. The layout is reflected in a diagram in the
middle of the dialog. Two sets of four radio buttons, to the right of
and below the diagram, select the number of rows and number of
panels per row.

The Tall, Wide, and HyperCard radio buttons select page size and
orientation. Tall is eight inches wide by ten inches tall. Wide is
ten inches wide by eight inches tall. These sizes were selected for
compatibility with MacPaint. HyperCard size is the same size as
the original Macintosh screen. It allows you to create comics that
can be saved as MacPaint and then loaded into HyperCard stacks.
It’s also good for creating comic startup screens.

The stretch handles on the page rectangle allow the area of the

File Menu
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page that will be filled with panels to be changed. Note that in a
HyperCard layout, the default panel layout leaves a small amount
of space at the top. This space is so that the comic won'’t be
partially obscured by the menu bar when the comic is imported
into HyperCard. If you are designing a stack in which the menu
bar will be hidden, or if you are using the HyperCard option to

make a startup screen, you might want to stretch the rectangle
upwards to cover the whole page.

All changes to the default layout will be shown in the diagram.
Clicking OK creates a new document laid out as shown.

Open...

brings up a modified Open dialog and allows you to open or create
a comic strip, parts, or text file.

0O ?/15 ATK = Pacific

D ATK Logos

D License Spells
0 MDay Comic
O Nerd Comivl | | e
O Nerd Comix Ila
D Nerd Comix 111

D Nerd Comix IU
0 Nerd Comix U 3| [ Cancel
@ Comic Strip QO Parts O Text

The three radio buttons at the bottom of the dialog act like those
in the New Document Type dialog: They determine the kind of file
to be opened or created. If a file of a given type is already opened,
the corresponding radio button will be dimmed. The first available
radio button will be the one selected when the dialog first comes
up. To open a file of a given type, select that type by clicking on its
radio button. The list of files presented will all be files of that type.
Click on the file desired, or use the standard Open dialog controls
to find the file you want in another disk or directory and then click
on the file desired, and click the Open button to open the file.
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To create a new document, click on the type of the document you
wish to create and click the New button. The program will proceed
as if you had selected that document type from the New
Document Type dialog: See New... above.

Install Background...

brings up the standard Open dialog and allows you to select a
MacPaint file to be the background picture for the current comic
document. It is available only when there is a comic file open that
does not already have a background associated with it (see
Change Background...). After it opens the Background window
and displays the picture, it brings up the Background
Dimensions dialog.

Background Dimensions:

@® Panorama (24" ® 3.33")
O Wide Screen (16" ¥ 5")
QO Portrait (8" ® 10")

( Change Picture | [ Blank |

The Background Dimensions dialog has three radio buttons to
set the background type. A MacPaint file is always eight inches
wide by ten inches tall. We call those dimensions Portrait
dimensions.

A background can be drawn in two other ways. One way is to

File Menu




divide a MacPaint picture into three horizontal strips then display
the strips as a single strip, three times as wide as the MacPaint
file, but only a third as tall; we call this Panorama.

The other divides the paint file into two horizontal strips and
reconnects them twice as wide as the MacPaint file, but only half
as tall; this is called Wide Screen.

922%2%%.%2%1%29%22222 22222 f

Once a background is installed and interpreted in one of these
three ways, any panel in the comic that is not larger than the
background picture in either dimension can have part of the
background picture copied into it as background.

2222222

Also on the Background Dimensions dialog are three buttons.
Change Picture brings up the standard Open dialog and allows
you to select another MacPaint file as the background. Blank
allows you to return to the original state of having no background
picture associated with the file. It closes the background window
and exits the dialog. OK accepts settings you've made and exits

The Comic Strip Factory User Manual

i
!
t
‘ p': 4: l: r: e e



N ST Jd T IIddddddddddddddéddddéddddddd

the dialog.

Change Background...

is available when a comic that already has a background
associated with it is open. It brings up the Background
Dimensions dialog, where you can change the dimensions of the
background or replace the background picture with another (see
Install Background...). Any changes made will affect backgrounds
in all panels that show background pictures.

Close

If the Comic window, the Text window, or the Parts window is in
front, Close closes the window. If there have been changes to the
file since it was opened or last saved, you're first asked if you want
to save your changes. If a desk accessory is frontmost, the Close
command closes the desk accessory. The desk accessory may then
ask if you want to save data. Since the background is part of the
comic file and not a separate document, if the Background window
is in front, the Close menu item is disabled. The background
window may be closed without closing the Comic window by
clicking the Blank button on the Background Dimensions dialog,
accessible through the Change Background... and Install
Background... commands. See Install Background....

Save

If the Comic window, the Text window, or the Parts window is
frontmost, the Save command saves the document in the window.
If the file has never been saved (when the window is titled
“Untitled”), the program will ask you for a file name through the
standard Save As dialog. See Save As.... Since the background is
part of the comic file, if the background window is in front, this
menu item is disabled.

Save As...

If the Text window or the Parts window is in front, this command
brings up the standard Save As dialog and allows you to name
and save the document in that window.

If the Comic window is in front, the Save As dialog includes two

radio buttons that allow you to choose between saving the comic
as a comic file or as a MacPaint readable file. Wide documents will

File Menu
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be rotated to fit into MacPaint format. Since The Comic Strip
Factory can’t open MacPaint files as comic files, it does not
consider that the document has been saved if it has only been
saved in MacPaint format. Closing the document will still result in
the program asking if you want to save it first.

<3 CSF Data
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Save the Comic Strip as: = Pacific
Untitled
| |
( save ] [ Cancel ] ( brive |

® Comic (O MacPaint

Since the background is part of the comic file, if the Background
window is in front, this menu item is disabled.

Print...

If the Comic window or Parts window is in front, this command
prints the document in that window. The Comic Strip Factory
begins printing immediately, without going through a standard
Print dialog. It does bring up a Now Printing... dialog, and allows
you to cancel by holding down the Command key and hitting
period.

If the Background window or Text window is in front, this
command is disabled.

Transfer...

Since The Comic Strip Factory is designed to use data from other
programs, we included Transfer... in the File menu. This allows
you to run another program without quitting to the Finder.
Transfer... asks if you wish to save open files before exiting. This
allows you to save changes, discard changes, or cancel the
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operation. If you don’t cancel, the standard Open dialog is
displayed after all files are closed. From this dialog you can select
an application to run.

In conjunction with the Transfer... item in PartMaker II, you can
move back and forth between The Comic Strip Factory and
PartMaker II quickly.

Quit
quits The Comic Strip Factory . It first closes any open documents
and, if they haven’t been saved, asks if you wish to save them.

Edit Menu

Undo
will undo most actions in the Comic window and Parts window.
Undoable actions include

¢ dragging,

¢ duplicating,

e deleting,

¢ Pasting, and

¢ all commands in the Object and Arrange menus.

Changes to panels, including changing the shape, background
picture, or panel pattern, can’t be undone.

In addition to Command-Z, the @ key is a shortcut for Undo.

Cut

in the Comic window and Parts window puts copies of the selected
objects on the Clipboard and deletes them from the document. In
the Text window it does the same with selected text. It is
unavailable from the Background window.

(The Clipboard is a Macintosh convention: it is where data goes
when cut or copied. The Clipboard only remembers the last thing
cut or copied. The contents of the Clipboard can be inserted at a
new location, in another document, or in some cases even in
another program’s document with the Paste command.)

Edit Menu




Copy
in the Comic window and Parts window puts copies of the selected

objects on the Clipboard. In the Text window it does the same with
selected text. It is unavailable from the Background window.

Paste

puts whatever is on the Clipboard into the selected window, if
applicable. Parts, groups, text objects, and silhouettes may be
pasted into the Comic window. Only parts may be pasted into the
Parts window: Groups, text objects, and silhouettes are converted
to parts. Only text may be pasted into the Text window. Nothing
may be pasted into the Background window.

Pasting graphics from outside the program into the Comic window
or Parts window has a few options. Multiple objects can be pasted
from sources outside The Comic Strip Factory . Also, pictures can
be pasted in as a single rectangular object.

Which type of Paste— “Paste as multiple objects,” or “Paste as one
object,” is determined by the picture on the clipboard and by
keyboard modifiers.

Follow along, and we’ll explain how it works.

Smart Paste

Without a modifier key, Paste first tries to separate distinct
objects in the picture. This is useful if, for example, you create a
set of parts (separate objects) in a paint program, then paste them
in all at once. If there are fewer than thirty-two parts on the
clipboard, Paste treats them as separate objects.

After separating the picture into objects, Paste checks to see if any
of the objects are close to other objects. (“Close” means separated
by only one white dot.) If the objects are close together, you
probably intended them as one object, not many separate objects.
And that’s what Paste assumes. The neighboring objects are then
merged together before pasting.

That’s one way smart Paste works. Here’s the other way: If a
picture on the clipboard contains more than thirty-two distinct
objects, the picture is pasted as a single object with a rectangular

The Comic Strip Factory User Manual
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background mask. This is a handy way to use part of a MacPaint
picture as a panel background.

(Note: Smart Paste applies only to pictures pasted from outside
The Comic Strip Factory, not overlapping parts copied from within
the program. Objects cut or copied within The Comic Strip Factory
will paste as they originally appeared, unless modified by a special
Paste command, as described below.)

Option-Paste
Option-Paste gives you more control over Paste.

If you hold down the Option key while pasting, the contents of the
Clipboard are pasted as a single part with a rectangular mask.
This applies to pictures cut from within The Comic Strip Factory or
from another source.

Subsequent Paste commands also paste this one object, unless
modified by the Shift key as described below.

Note on using objects as background...
As we mentioned above, a single object with a rectangular
mask is useful as an alternate panel background.

Such an object isn’t the same as a standard background,
though. It should be “sent to the back,” or it will cover other
objects in the panel. Also, be careful not to send other objects
behind it. The “background object” can still be selected and
moved as an object, so you won't be able to start a selection
rectangle in that panel.

Even sent to the back, the background object is in front of the
“real” background pattern, so the Background Pattern...
menu item can’t be used to lighten or darken it.

You can, however, do this: Make a silhouette of the object,
bring the silhouette in front of the object, select a pattern and
whether to darken or lighten from the Set Pattern... dialog.

This is one workaround to the limitation of one background
picture per file. Another workaround is to use a paint program

Edit Menu




shift

to create a composite background file from the desired parts of
two or more existing background files.

Shift-Paste
Shift-Paste is the opposite of Option-Paste. It tells the program to

try harder to paste the clipboard as separate objects with fitted
background masks.

If the clipboard contains objects copied from The Comic Strip
Factory, Shift-Paste first makes the objects into a single picture,
then attempts to separate them.

Shift-Paste is somewhat different from the standard Paste
command. Shift-Paste tries to merge objects with neighboring
objects as each object is created instead of waiting until all objects
are found. This means the thirty-two object limit is reached much
later than with the standard Paste command. (The trade-off is
that Shift-Paste isn’t as fast as Smart Paste.)

Here’s an example.

You use standard Paste with a picture from a paint program. You
want to paste separate objects, but standard Paste interprets the
clipboard as a single rectangular object.

To force the issue— to make Paste try harder to separate objects—
try again with Shift-Paste.

If the Clipboard still pastes as a single object, try pasting fewer
items at a time.

Shift-Paste is also useful for splitting one object into two objects.
Using Edit Bits..., erase enough of the object’s black bits to
simulate two separate objects. (Black bits of the intended separate
objects must be separated by at least two dots.) It’s not necessary
to erase the white bits. Click OK. Copy the object to the clipboard
then Shift-Paste. The clipboard will paste in as two objects.

Like Option-Paste, Shift-Paste changes the contents of the
clipboard to the set of objects just pasted.

The Comic Strip Factory User Manual

;
l

7297

1698992797797

-~

{

TRYRYE,

bt bt e b R L

[



NIl ddldddd il ddddddddddddddddddddddddd

If both the Option key and the Shift key are held down while
pasting, the Shift key will be ignored and an Option-Paste will be
performed.

Pasting Recap
Here again, in abbreviated form, are the various ways to paste:

Paste, if fewer than 32 objects, tries to paste as separate objects.
Neighboring objects are merged. If more than 32 objects, pastes as
a single rectangular object.

Option-Paste pastes as a single rectangular object.
Shift-Paste tries harder to paste as separate objects.

Clear

if the Comic, Text, or Parts window is in front, Clear deletes
whatever is selected, without storing it on the Clipboard. The
previous contents of the Clipboard, if any, remain intact. The
Clear command is unavailable in the Background window.

Show Page...

if the Comic window is in front, displays a miniature version of the
layout of the comic document. The comic displayed is simplified:
all objects are shown as black outlines around white shapes, and
panels with any other background but white are shown in light

Edit Menu P\



gray. The current panel has a bolder outline than the other
panels.

A new panel may be chosen as the current panel in the Show
Page dialog by clicking in it. Clicking outside of the panel
boundaries places a crosshair on the miniature page at that point.

N%29292%2%2°7°?P

L

Entering Show Page mode brings up an OK and a Cancel button
on the right-hand end of the icon bar. If the last click on the
miniature page was inside a panel, clicking the OK button scrolls
the document to that panel. If the last click was outside all of the
panel boundaries, clicking OK scrolls the document to that point.
Clicking the Cancel button closes the miniature page without
changing the selected panel or scrolling the document.

4 9¢¢Ga

Panel Menu

v
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@ Add Rectangle

is available when the Comic window is in front. It creates an
animated, stretchable rectangle the same size and location as the
selected panel and places you in panel reshaping mode. OK and
Cancel buttons appear on the icon bar. In this mode, you can
scroll the document or select a different panel. You cannot select
or move objects, issue other commands, or bring other windows to
the front. The purpose of this mode is to reshape a panel by
adding the animated shape to it or to create a new panel from the
animated shape. You can exit this mode without changing the
panel layout by clicking the Cancel button on the icon bar.
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The animated rectangle has nine stretch handles: one on each
corner, one on each side, and one in the middle. By grabbing the
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stretch handles, you can move or reshape the rectangle. Clicking
the OK button on the icon bar has several possible effects:

¢ If the animated rectangle borders or overlaps the selected panel
and the Command key is not held down, the animated rectangle
is added to the selected panel and subtracted from other
overlapping panels.

¢ If the animated rectangle does not border on the current panel,
a new panel is created from the animated rectangle, the shape
of which is subtracted from overlapping panels.

¢ If the Command key is held down while OK is clicked, a new
il panel is created from the animated rectangle, the shape of
which is subtracted from overlapping panels. The background

pattern and picture in the new panel will be consistent with the
background in the selected panel.

¢ If the Shift key is not held down while OK is clicked, panel
reshaping mode is exited and the animated shape is discarded.

¢ If the Shift key is held down while OK is clicked, panel
shift reshaping mode is not exited. The same rectangle can be added
to the same panel or another panel, or a new panel can be
created from it, by moving or reshaping it and clicking OK
again.

I@ Add Oval

— is available when the Comic window is in front. It creates an
animated, stretchable oval the same size and location as the
selected panel and places you in panel reshaping mode. This is
used primarily for adding curved edges to panels and making




circular panels. See Add Rectangle.

Add Triangle

is available when the Comic window is in front. It creates an
animated, stretchable triangle the same size and location as the
selected panel and places you in panel reshaping mode. The
triangle, having only three sides and three corners, has only seven
stretch handles. This is used primarily for adding slanted and
jagged edges to panels. See Add Rectangle.

| - = - ||

Background Pattern...

if the Comic window is in front, brings up the Background
Pattern dialog, allowing you to set a number of background
options in the current panel. Panel backgrounds consist of part of
the background picture and a pattern. Either the picture or the
pattern may be unused. The Background Pattern dialog contains
thirty-eight patterns which you can select by clicking. The large
square on the left displays the current pattern.

NNV

X Use pattern: @ as background
O to darken background

O to lighten background

The dialog has a check box and three radio buttons. Using these
controls, you can set up one of four situations.
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¢ If the Use pattern checkbox is unchecked, the three radio
buttons are dimmed; their settings are remembered, but
ignored. The panel will display the background picture without
any pattern modification.

¢ If the Use Pattern box is checked and the as background radio
button is on, only the selected pattern is used as the
background; no picture is displayed.

e If the Use Pattern box is checked and the to darken
background button is on, the selected pattern is washed over
the picture like a watercolor. White parts of the picture are
darkened (replaced with the pattern) and black parts are left
alone.

¢ If the Use Pattern box is checked and the to lighten
background button is on, the selected pattern is subtracted
from the picture, producing an “overexposed photograph” effect.
Black parts of the picture are lightened (replaced with the
pattern) and white parts are left alone.

If the Parts window is in front, Background Pattern... brings up
the same dialog without the check box or radio buttons. This is
used simply to select a background pattern for the Parts window.
The menu item is unavailable for other windows.

Copy to Panel

is available in the Background, Parts, and Text windows, but not
in the Comic window.

¢ In the Parts window, it copies the selected part or parts into the
current panel and brings the Comic window to the front,
scrolling to the selected panel if necessary.

¢ In the Background window, it places the part of the background
surrounded by the animated shape in the background of the
selected panel and brings the Comic window to the front,
scrolling to the selected panel if necessary.

¢ In the Text window, it copies the selected text into the balloon
editor (see Add Text...), allowing the user to edit the text and

Panel Menu :




specify formatting information. If OK is clicked, a new balloon
will be created and placed in the current panel. The Comic
window will be brought to the front, scrolling to the selected
panel if necessary.

Remove Panel

is available when the Comic window is in front and there is more
than one panel in the document. It deletes that panel from the
page. Although the panel’s background will be lost, any objects in
the panel remain where they are, freed from panel boundaries.

Objects Menu

Edit Text...

is available in the Comic window when a text object is selected. It
brings up the balloon editor screen with the text of the selected
balloon, formatted as in the balloon, in the text area.

The balloon editor is like a basic word processor in a single screen.

When you use the balloon editor, menus are disabled; all balloon
editor functions are available through controls on the screen. The
editor is exited through the OK button or the Cancel button on
the icon bar.

" & File Edit Panel LI I-I4E38 Arrange Windows

@» 2511514 MY ( cancel J (oK)
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Beach Empha

Characters typed at the keyboard are inserted in the text area.
Clicking the mouse in the text area places the cursor for text
insertion. Clicking and dragging over text selects that text.
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Double-clicking on a word selects the word. Double-clicking and
dragging selects a range of words.

Clicking on the scroll bar scrolls the text up or down. Clicking on
the icon at the bottom of the scroll bar and dragging it left or right
resets the width of the text area. The width of the text area
controls the width of automatic word wrapping. Text can be
wrapped manually by typing returns.

The Cut, Copy, and Paste buttons duplicate commands on the
Edit menu. Cut copies the selected text into the Clipboard and
deletes it from the text area. Copy copies the selected text to the
Clipboard. Paste inserts the text in the clipboard at the insertion
point, or if text is selected replaces the selected text with the
contents of the clipboard. Cut, Copy, and Paste have keyboard
equivalents of Command-X, Command-C, and Command-V,
respectively.

In the center of the control area is a scrolling list of fonts available
from the current system. Clicking on a font names and clicking
the Set Font button, or double-clicking on the font name, changes
the selected text to that font. If no text is selected, it sets the font
for subsequent text entered at the insertion point.

On the right side of the control area are buttons for setting the
style and size of selected text or of text subsequently entered at
the current insertion point. The number buttons set point sizes;
the lower six buttons set styles. Style buttons have keyboard
alternatives consisting of the Command key and the first letter of
the style name: Command-B sets bold, for example.

Three rows of icons in the lower left corner of the control area set
text alignment and set the appearance of the balloon. The top right
set of three icons set text flush left, centered, and flush right.
These changes are reflected immediately by the text displayed in
the text area. The top left set of icons control the thickness of the
line used to draw the balloon: from left to right, the settings are no
line, one pixel thick, and two pixels thick. The bottom row of icons
controls the type of balloon created. The balloon is not created
until you click OK, so changes made by clicking on these icons
aren’t apparent until then.

Objects Menu




Command-K sets the selected text to all capital letters, and
Command-L sets the selected text to all lower case letters.

Add Text...
is available in place of Edit Text...'when the Comic window is in
front and nothing is selected. It brings up the balloon editor with

an empty text area and allows you to create a balloon from
scratch. See Edit Text....

Edit Bits...

is available from the Comic window and the Parts window when
one part, text item, or silhouette is selected. It cannot be used
with multiple objects or groups. The command brings up the bit
editor screen and lets you edit the selected part in a FatBits-like
manner. In the bit editor, all menus are disabled; available
controls are the mouse, the tools and other icons on the left, and
the OK and Cancel buttons on the icon bar, which are used to
exit the mode.

" & File Edit Panel JALYCISCH Arrange Windows

G362 BB % : ‘ .@. @[ : .3 Cancel 0K

There are actually two pictures, superimposed on each other, that
can be edited in the bit editor. One, represented by black squares,
is the picture of the object. The other, represented by white
squares, is the background mask: the white part of the object
through which the background can’t show. Think of the white bits
as a paper cutout where black bits are drawn. The gray area is the
background: it doesn’t represent part of the object. The general
rule is that black bits may only be drawn on white, not on gray,
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and white bits may only be drawn on gray, not on black (because
there is already white under the black). You also can’t erase the
white underneath black bits unless you first erase the black.

Which plane you are drawing on or erasing from is determined by
the two radio buttons on the left. Selecting the one with an icon
showing black bits against a background of white bits allows
drawing or erasing black bits. The one showing white bits against
a gray background allows the editing of white bits.

These options are only available when you are editing a part.
When editing text items and silhouettes, you can only edit white
bits, and the black bits radio button doesn’t appear.

The four tools are selected by the icons on the left, above the radio
buttons. The tools are similar to tools with the same icons in
MacPaint and other programs. The hand tool allows the object to
be scrolled. Holding down the Option key while any of the other
tools are active brings up the hand tool temporarily. Double-
clicking on the hand icon centers the object. Holding down the
Command key while dragging causes the scrolling to be restricted
to the first axis along along which you move the mouse.

The pencil icon is a pencil that acts on the selected plane (black or
white— see above). If you click first on a bit that is off and drag, it
acts as a one pixel wide pencil. If you click first on a bit that is on
and drag, it acts as a one pixel wide eraser.

The bottom two icons are each a “hard wired” brush and eraser.
They paint or erase the selected bitmap in swaths as wide as their
cursors.

Create Part...

is available when the Comic window or Parts window is in front
and nothing is selected. It replaces Edit Bits... in the menu. It
brings up the bit editor with no object drawn in it and allows you
to create a part from scratch. See Edit Bits....

Duplicate

is available in the Comic window or the Parts window when one or
more objects of any type are selected. It makes copies of the

Objects Menu




selected objects, placing them below and to the right of the
originals.

Invert

is available in the Comic window or the Parts window when one or
more objects of any type are selected. It inverts the objects
selected. It has no effect on silhouettes.

Flip Horizontal

is available in the Comic window or the Parts window when one or
more parts, silhouettes, or groups that don’t contain text items are
selected. Text items and groups containing text items cannot be
flipped. The command flips each object around its own vertical
axis, swapping left for right.

Flip Vertical

is available in the Comic window or the Parts window when one or
more parts, silhouettes, or groups that don’t contain text items are
selected. Text items and groups containing text items cannot be
flipped. The command flips each object around its own horizontal
axis, swapping top for bottom.

Rotate

is available in the Comic window or the Parts window when one or
more parts, silhouettes, or groups that don’t contain text items are
selected. Text items and groups containing text items cannot be
rotated. The command rotates each object ninety degrees counter
clockwise around its own center point.

Point Balloon

is available in the Comic window when one text item is selected. It
enters pointer adding mode, which is used to add a pointer to that
balloon.

In this mode, when the mouse cursor is in the window and not
over the balloon, the cursor changes to a picture of a balloon with
a pointer on it. A stretchable pointer from the center of the balloon
comes to a point at the cursor’s pointer. If you click the mouse
button when the cursor looks like a balloon and the pointer is
visible, the pointer is added to the balloon. If the cursor is arrow
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shaped when the mouse is clicked, the mode is exited without
adding a pointer to the balloon.

D%" Untitled

=

“A "CHUNK STYLE'
MATTER TRANSPORTER?"
1 SAID, “HOW GOOD
COULD T#4TBER”
“WHO CARES™ HE SAID,
“IT'S ON SALE!S” “WELL

SOREITIS,” I SAD...

More than one pointer can be added to a given balloon. To revert
the balloon to its original state, select it, choose Edit Text... from
the Objects menu, and click OK.

Make Silhouette

is available in the Comic window when any object or objects are
selected. The command duplicates the shape of the objects in
black silhouette form, offsetting the silhouette below, to the right
of, and underneath the original object. Silhouettes are good for
making shadows or for lightening or darkening a portion of the
picture for some other purpose.

Set Pattern...

is available in the Comic window when one or more silhouettes are
selected. It brings up a Silhouette Pattern dialog similar to the
dialog used for background patterns.

Silhouette @ covers background
O darkens background

QO lightens background

Objects Menu




You can select a pattern for the silhouettes selected by clicking on
the pattern; it will be displayed in the box on the left. Three radio
buttons allow you to determine how the pattern is drawn. If you
select covers background, the silhouette will be opaque. The
darkens background and lightens background buttons cause
the silhouette to be translucent; whatever is under the silhouette
will show through, but it will be lightened or darkened by the
pattern selected. Note that it is possible to make silhouettes
invisible and lose them by having them lighten an already white
background or darken a black one.

MergeBits

is available in the Comic window and the Parts window when one
or more objects are selected. If only one object is selected, it must
be a group, text object, or silhouette. The command merges the
selected objects into a single part.

This is superficially similar to the Group command in the Arrange
menu. The difference is that Group remembers each object
separately and allows them to be ungrouped later. MergeBits
makes them all into a single part; it cannot be undone. Group
makes it easy to treat an assembled character as a single object
while still having the freedom of ungrouping them and exchanging
a head or a hand. MergeBits creates objects that can be edited
with Edit Bits... and flipped or rotated even if they contain text,
although text objects made into parts with MergeBits can no
longer be edited as text.

Groups always take up slightly more memory than the component
parts, while several objects made into a single part with
MergeBits usually take up less memory than the original set of
objects. The exceptions to this rule are when a single text object or
a single silhouette is merged, as text objects and silhouettes use
less memory than equivalent parts, and when two or more parts
that don’t overlap are merged. Finally, merged parts are usually
drawn faster than equivalent groups. A text object merged into a
part is always drawn faster, and two parts that are merged are
usually drawn faster.

The Comic Strip Factory User Manual
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Arrange Menu

Bring to Front

is available in the Comic window and the Parts window when any
object or objects are selected. It brings objects that are restricted
to a panel up in front of all other objects in that panel, but not in
front of freed objects, and objects that are freed from panel
boundaries in front of other freed and restricted objects. (See Free
from Panel.) Since there are no panels in the Parts window, it just
brings objects in the Parts window to the front of all other objects.

If the Shift key is held down while this command is issued, the
selected objects are each moved one step forward instead of all the
way to the front.

If the Option key is held down while this command is issued,
restricted objects will be freed from their panels and brought to
the front of freed objects as well as restricted objects.

Send to Back

is available in the Comic window and the Parts window when any
object or objects are selected. It sends objects that are restricted to
a panel behind all other objects in that panel and objects that are
freed from panel boundaries behind other freed objects, but not
behind restricted objects. (See Restrict to Panel.) Since there are
no panels in the Parts window, it just sends objects in the Parts
window behind all other objects.

If the Shift key is held down while this command is issued, the
selected objects are each moved one step backward instead of all
the way to the back.

If the Option key is held down while this command is issued, freed
objects will be restricted to panels and send behind other
restricted objects as well as freed objects.

Group

is available in the Comic window if more than one object is
selected. It makes the selected objects into a single group object. If
the group is selected or moved, all the objects in it are selected or
moved. Anything done to the group is done to all members of the

Arrange Menu
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group. All objects in a group that is rotated or flipped are rotated
or flipped around a common center. Groups that contain text
objects cannot be rotated or flipped.

w Sy Ay iy

Although Group is superficially similar to MergeBits, they are
really quite different. See MergeBits for a discussion of the relative
merits of the two commands.

Ungroup

is available in the Comic window when a single group is selected.
It breaks down the group into its component parts. Note that a
group may contain other groups; Ungroup only undoes the top
level of grouping.

v Ty Ty By P

Free from Panel

is available in the Comic window when one or more restricted
parts are selected. The command frees the parts from their panel,
allowing them to overlap panel boundaries. They will initially be
behind previously freed objects. Freed objects are always in front
of objects that are restricted to a panel.
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Restrict to Panel

is available in the Comic window when one or more freed objects
are selected. The command restricts the selected objects to the
selected panel, if they overlap it. The objects will be in front of all
previously restricted objects in that panel. Restricted objects are
always behind freed objects.

b kel el e b RS
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Windows Menu

Comic Strip
is available whenever the Comic window is open. It brings that
window in front of all other windows.

Background
is available whenever the Background window is open. It brings
that window in front of all other windows.

Text
is available whenever the Text window is open. It brings that
window in front of all other windows.

Parts

is available whenever the Parts window is open. It brings that
window in front of all other windows.

Using PartMaker II

PartMaker Il is a utility for converting paint files into Parts files. It
scans the paint file for conceptually separate objects and makes
them into separate parts. It works best with clip art style paint
files that are drawn as collections of separate objects. It works
poorly with full page images like backgrounds from The Comic
Strip Factory, as it depends on white space between objects to
determine boundaries. This function was written as a separate
application instead of being integrated into The Comic Strip Factory
because it temporarily uses a lot of memory.

To convert a paint file, open PartMaker II from the Finder. Choose

Convert Paint... from the PartMaker 2.0 menu. Open a paint file.
PartMaker II brings up the Converting Paint dialog.

Windows Menu




Converting paint file “neslgns for Living” into comic pnrts

5 g R %

g\“ m&

-t~
Copyright ©1987, Foundation Publishing, Inc. All rights reserved.

“Designs for Living” is part of Mac the Ripper, copyright ©1986 by Miles Computing, Inc. Used by permission.

The paint file is at the left. As parts are found, they’re copied to
the rectangle on the right. The thermometer shows the
conversion’s progress. The word above the thermometer shows the
conversion stage in progress: “Tracing...” when the object’s edge is
being traced, “Copying...” when the object is made into a part, and
“Merging...” when other parts are checked for possible merging.

You can press Cancel at any time to stop the process and save
parts already converted.

When the entire paint file has been converted, or when you cancel,
a Save dialog allows you to save the new parts file to disk.

It helps to clean up MacPaint files before converting them by
removing unwanted parts, labels, unfinished sketches, stray bits,
and copyright notices (although you should heed these if you
intend to publish your work).

Parts created in PartMaker II generally still need to be cleaned up
with Edit Bits..., especially to repair “leaks” in the background
mask that allow the background to show through undesired areas
(like a face). To detect these leaks, open the Parts file in The Comic
Strip Factory , choose Background Pattern... to set a gray pattern
for the background of the Parts window, and scroll through the
file, looking for parts that have gray areas which should be white.

The Comic Strip Factory User Manual
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Select those parts, choose Edit Bits..., and fill in those areas by
painting them white.

You may find that this happens: PartMaker Il may interpret as
“many parts” a part that—to you—appears as a single part. This
happens when “stray pieces” aren’t connected to the main part.
You can fix this by dragging a selection rectangle around the set of
parts, without disturbing any, then choosing MergeBits. You may
still have to use Edit Bits... to fix stray holes. Be sure to Save the
parts file after fixing it up.

Keyboard Shortcuts & Extensions

Comic window:
Tab scrolls to the selected panel.

Edit menu:
is a shortcut for Undo.

Option-Paste pastes as a single rectangular object.
Shift-Paste tries harder to paste as separate objects.

Arrange menu:

Option-Bring to Front causes objects to be freed and brought
to the front of other freed objects.

Shift-Bring to Front causes objects to be moved one layer
forward.

Option-Send to Back causes objects to be restricted to the
current panel (if they overlap it) and sent behind other
objects in the panel.

Shift-Send to Back causes objects to be moved one layer
backward.

Selecting and moving objects:
Shift selects new object without deselecting.
Option duplicates the objects being moved.
Command restricts movement to one axis.
Arrows or Command-I, J, K, and M move object one pixel.

Keyboard Shortcuts & Extensions P Y
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Panel reshaping mode:
Shift-clicking OK causes the program to remain in panel
reshaping mode.
Command-clicking OK forces a new panel to be created with
background consistent with current panel.

YWAANANA

Edit Bits mode:
Option changes tool to the grabber for easy scrolling.

Balloon editor:
Command-X cuts the selection to the clipboard.
Command-C copies the selection to the clipboard.
Command-V pastes the clipboard at the insertion point.

79 ¢

Command-P sets the style of the selection to plain.
Command-U sets the style of the selection to underline.
Command-B sets the style of the selection to bold.
Command-I sets the style of the selection to italic.
Command-O sets the style of the selection to outline.
Command-S sets the style of the selection to shadow.

Lo

LWL %%

Command-K makes letters in the selection upper case.
Command-L makes letters in the selection lower case.

By

Option-Shift on The Comic Strip Factory’s fonts get a bevy of
special characters:

Tl

& e SIRGEE SOXIRIe  SoHoKEC  NeRlr  FSO0BIS WHETEL 3Ry 24 0T TR
1 2 3 4 5 6 7 8 9 0 -

Ly

A ‘o 4o " o <%
w E R T Y U
S > < 5 o o
S D

Zrzy  EEKUL Y9 ay SSNELE  3INEE K]
z X B M /

VN

N Y

S
S

-
®
T
(25
— Nie

Other special characters are on the @ key, which contains the
character #4, and Option-?, which displays ¥ .
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LET'S HIRE ANOTHER
#| ART DIRECTOR TO
: LEHTEN HIS LOAD--

28 )

| SOFTALE' 1983:
DURKEE" NG Eql:

THE STORY YOU ARE ABOUT :
TOWITNESS IS TRUE., HO NAMEES neg

HAVE BEEN CHANGED BECAUS
THERE ARE NO INNOCENT. EDITORIAL

BY 1 Tvpes!
SR GRRRRRRR!

1 L]
NOW WHAT WE HAVE HERE, TRICI IS A NO-WIN NDRE,
PROPOSITION -FOR Y YOU TAKE THIS | CHRISTIES WHO
0B, YO HAVE T0 WORK WITH RORT, ShD I e
| YOU DON'T TAKE THIS JOB, WE'RE SENDING YOU || &
TO TAHITI WITH KURT FOR TWO WEEKS.

YOU'RE THE EDITOR OF
SOFTLINER® I'MYOUR 4
NEW ART DIRECTOR

I'LL TAKE THE JOB!
I'LL TAKE THE JOB!
... WHAT IS THE JOB?

WE HAVE TO FOLD SOFTLINE!
THE PRATES HAVEKILLED IT! || |
ANDREW, YOU GO WORK WITH

DORKEE ON SOFTALK APPLE H'Jj%{}&"ggé—b"om
EDITORIAL. TRIC], YOO TAKE || [HELPF OO DREW ONJ

OVER AS A.D. FOR ST. MACS

KORT'S TOO BUSY TODO T THE MAGAZINE. :
NOW THAT HE AND MITHRA® =
ARE PUTTING TOGETHER DOUG DRAW ON A

: COMPUTER?! ME?

(GROAND TAHITI IS
LOOKIN' BETTER
ALL THE TIME,

HE'LLWRITE
FORTHEOTHER

1. Softalk Publishing, North Hollywood, CA: The firstoutfit dedicated to the principle of writing computer magazines in lay English, with lots
of pictures. 2. David Durkee: hot young technical writer imported from Vermont. 3. Kurt Wahiner: Head of Softak art department, famed
for his great talent and nasty temper. 4. Trici Venola: freelance illustrator hired after pounding on Softak’s door for two years. 5. Andrew
Christie: Editor of Softline, comic maven. 6. Softiine: Games magazine beloved by pirates, eschewed by advertisers. 7. Hi De Ho Comics
& Fantasy in Santa Monica, CA: Probably the best comic book store in the whole world. 8. ST.Mac: The firstMacintosh magazine. 9. Paul
Mithra: Enormouslypopulardirectorof Softalk book division. 10. Doug Clapp: Author of Macintosh Complete, in from Minnesota to oversee
publication. 11.Jock Root: Softak contributing writer and resident wizard.




THIS'S MY NEW
ROOMMATE, CLINT! HE'S
NTO COMPOTERS, TOO!

NEW TYPE, | PEFURE GO MAKE ME

HERE'S THE | OBOYY WHERE DOES MY
KORT! LOOK LKEA ROCK STAR?

SAY,
THIS'S FUN!

sCHokeZ AND
NOTONLY
THAT—
\e ﬁlg;
wnlh:z.i"e

R a1l

YOU AND KORT ARE GETTING
MARRIED 2\ /i 18 14 477!

I ITE COMI BOOKS/ STOP TELLING
MEABOUT 'EMIIAND STOP BUGSING
ME?DHT"IMVE'?OOM A

» YOU'DLOOK LIKE A SNAR
STRING INSTEAD OF A
TOOTHPICK ==

AUGUST 1984:

BNV AT L7 7 o] YO0 SANE SAD YO0 Co0LENT
PROGRAM IT2? I
X SOFTALK FOLDED? ° 1| CANTPROGRAM PROGRAM ON THE

WHAT'LL WE DO MAC!
NOwW 22U

I THOOGHT YOO
SAID YOU
COULDN'T STAND
COMPOTERSH

I THOOGHT YOO
SAID YOO HATED

-AND WE ALL B COMIC BOOKSH

l work so wete [Kd
@ TOGETHER...

12. Clint Hicks: Postcollegiate computer sharpie up from Texas.

Cast of Characters: The Comic Strip Factory:

2. David Durkee: Programmer, copublisher. 3. Kurt Wahiner: Background design. 4. Trici Venola: Characterdesign, original Factory
concept. 5. Andrew Christie: Manual coauthor. 9. Paul Mithra: Laserprinting expertise. 10. Doug Clapp: Copublisher. 12. Clint
Hicks: Manual coauthor. Not in comic: Ken Ryall: Copublisher.
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Background: A MacPaint file loaded into a comic strip file. It may be
interpreted as a Panorama (a 24" wide by 3 1/3" tall strip) a Wide Screen
(16" by 5") or a Portrait (8" by 10"). Panels that are not larger than the
background type chosen may have portions of the background picture
copied into them.

Balloon: A shape containing text for either narrative or dialog. Also a text
object.

Cancel: A button on the icon bar (with OK) used to exit special editing
modes without accepting any changes to the thing being edited.

Character: An actor in a comic strip, built up of parts.

Comic: A graphic document built up of panels, backgrounds, characters,
and balloons. Occasionally humorous.

Group: An object in a comic that is a collections of parts, text objects,
silhouettes, and other groups. It may be moved around as a single object,
or ungrouped to get at the individual objects that make it up.

Icon Bar: The strip under the menu bar containing fourteen icons,
duplicating the features of the most frequently used commands in the
program’s menus, and two buttons used in special editing modes.

Object: Any thing that can be moved around in a comic strip. There are
four different kinds: parts, text objects, silhouettes, and groups, each with
special characteristics and capabilities.

OK: A button on the icon bar (with Cancel) used to exit special editing
modes and incorporate changes to the thing being edited.

Panel: A structural element in a comic strip. A shape used to contain
background and characters.

Part: A bitmapped object. May be a head, body, arm, hand, foot, leg, or

Glossary




miscellaneous segment or personal prop of a comic character.

Silhouette: Just what it sounds like; can also be used behind parts as
shadows. Created from other objects, they are exclusive to Comic Strip
Factory and can’t be loaded or pasted in from MacPaint.

Text Object: Text in the form of dialog, thought balloons, and narrative
boxes, which can be varied by font, style, and size in the balloon editor. A
text object can have one or more pointers added to it to indicate the
character speaking.

The Comic Strip Factory User Manual
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Appendix A

Recommended Reading

The following list is a sampling of work currently available by some of the
best comic practitioners of the last forty years. They can show you how it’s
done. (They've showed other comic creators for years.) All titles are
available at comic specialty stores or directly from the publishers.

Periodicals

Weirdo, Aline Kominski Crumb, ed. Last Gasp Eco-Funnies, P.O. Box 212,
Berekeley, CA 94701. Single copy price $2.50.

Steve Canyon Magazine, by Milton Caniff. Kitchen Sink Press, 2 Swamp
Road, Princeton WI 54968. Single copy price $3.50.

The Fabulous Furry Freak Brothers, by Gilbert Shelton. Rip Off Press, P.O.
Box 14158, San Francisco, CA 94114. Single copy price $1.50.

Kurtzrnan Komix, by Harvey Kurtzman. Kitchen Sink Press, 2 Swamp Road,
Princeton, WI 54968. $1.50.

Love and Rockets, by Los Bros Hernandez. Fantagraphics Books, 4359
Cornell Road, Agoura, CA 91301. Single copy price $2.25.

Books

“The Carl Barks Library of Walt Disney’s Donald Duck.” Another Rainbow
Publishing, Inc., Box 2206, Scottsdale, AZ 85252. Ten boxed sets,
sometimes available in single volumes.

“Frontline Combat.” Russ Cochran, Publisher, P.O. Box 469, West Plains,
MO 65775. 3-volume boxed set, $70.

“The Smithsonian Collection of Newspaper Comics.” Blackbeard and
Williams, eds. Smithsonian Institution Press, Washington, DC 20560. $25.

Appendices




Appendix B
Getting Published

Before submitting your work to any syndicate or publisher, write the
Submissions Editor to request a copy of their submission guidelines.
Enclose a long (business size), stamped, self-addressed envelope.

Major Comic Strip Syndicates

United Feature Syndicate
200 Park Ave.
New York, NY 10166

King Features Syndicate
235 East 45th St.
New York, NY 10017

News America Syndicate
1703 Kaiser Avenue
P.O. Box 19620

Irvine, CA 92714

Universal Press Syndicate
4400 Johnson Drive
Fairway, KS 66205

McNaught Syndicate
537 Steamboat Road
Greenwihch, CT 06830

Tribune Media Services
720 North Orange Avenue
Orlando, FL 32801

Major Comic Book Publishers

Marvel Comics Group
387 Park Avenue South
New York, NY 10016

DC Comics Inc.
666 Fifth Avenue
New York, NY 10103

First Comics
435 North LaSalle
Chicago, IL 60610

Eclipse Comics
P.O. Box 199
Guerneville, CA 95446

Comico
1547 DeKalb St.
Norristown, PA 19401

Eagle Comics
58 St. Giles Street
London, WC2H S8LH ENGLAND

Fantagraphics Books
4359 Cornell Rd.
Agoura, CA 91301

Continuity Publishing, Inc.
62 West 45th Street
New York, NY 10036

Kitchen Sink Press, Inc.
No. 2 Swamp Road
Princeton, NJ 54968

The Comic Strip Factory User Manual
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Appendix C

Comic People

Comic People Join
The Comic Strip Factory

Minneapolis, MN- Comic enthusiasts wept for joy as Foundation
Publishing today announced Comic People Volume One: Office Days, the
firsdt volume of additional art for The Comic Strip Factory.

SRR S MR OHOKESh K 25 SOBZZwHEEZESL-

...Well, maybe we should just tell you about Comic People, and skip the
press release format!

Comic People is what The Comic Strip Factory customers asked for: More
characters. Human characters. A completely new cast of seven comic
characters in various ages, shapes, sexes, and all the popular ethnic groups.
As the package says:

A COMPLETELY NEW CAST OF COMIC PEOPLE!
CREATE THOUSANDS OF LIFE-LIKE POSITIONS!

Two disks, stuffed with characters and backgrounds! Each character
has dozens of heads, bodies, arms, and legs! Put ’em together any
way you want! For comics, ads, storyboards, pamphlets, newsletters,
and more! Use Comic People with any MacPaint-compatible program!

The first Comic People collection, Office Days, is $39.95. To purchace
Comic People, see your computer dealer, call your favorite mail-order
company, or call us: (612) 925-6027!

Here’s a sample:

1 Office Days! -
From the corridors of power... Mrs. B? It's about 90 degrees -

out here! Could you just turn (Wrong

——— - ” the air conditioning on for a ] A\ floor?)

It's a beautiful se i

l:vav. don't yoo

...to the corridors ovtsioe
the corridors of power!
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YEARS AGO I WAS BOT IT DID HAVE IT*S LITTLE SO MY FRIENDS BACK IN
IN THE PEACE INCONVENIENCES. THE THIRD THE STATES TOOK TO
CORPS IN WORLD DOES WITHOOT A SENDING ME RECIPIES.
JAMAICA. IT WAS LOT OF THINGS THAT WE Y'KNOW, IF YOU MAKE
A GLORIOUS TAKE FOR GRANTED. FOR YOUR OWN MAYONNAISE
EXPERIENCE. EXAMPLE, IT WAS IMPOSSIBLE YOO CAN FLAVOR IT ANY
’ TO GET...MAYONNAISE.
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WAY YOO LIKE!...
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POSSIBLY COULD!

EVERY BIT OF IT, AS OFTEN AS [

l AND, AS YOO CAN SEE, I ENJOYED

4% 4% ONETONO'
MAYO-= %h

Featuring characters from Comic People Volume One: Office Days.

‘WHEN CHRISTMAS CAME, WE AMERICANS
POT ON A TALENT SHOW. AND WOULDN'T
YOU KNOW, THEY /ANSSTEL THAT I
PARTICIPATE. IDECIDED TO PAY TRIBUTE
TO THE GLORIOUS REVOLUTION OF THE

PEOPLE OF COBA BY THE FOLLOWING
SONG: (AHEME)
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Add Oval 12-13, 59
Add Rectangle 12-13, 58-59
Add Text... 10, 20, 64
Add Triangle 12, 60
Apple menu 46
Arrange menu 69-70, 73
Arrow keys 73
Art Grabber 26
as background 18, 61
auto-scroll 42-43, 45
background 14-17, 55

mask 64

pattern 17, 19, 37, 59

picture 16-19, 37, 39-40,

42-43, 49-51, 59, 61
Background (in Windows menu) 71
Background Dimensions

dialog 17, 49-51
Background Pattern
dialog 18, 43, 60

Background Pattern... 10, 17-19,
28, 55, 60-61, 72

Background window 16, 39, 42-43,
49, 51-54, 57, 61, 71

backspace key 42, 45
balloon editor 20, 38, 40, 44,
61, 62, 64, 74

balloons 19-21, 23, 25-26, 38,

44, 62-64, 66-67
bit editor 64-65, 74
bitmap 35, 65
black bits 64-65
Blank 17, 50-51
Bring to Front 9, 69, 73
brush 25, 65
Bubbles & Pointers 23

C

Cancel (in icon bar) 20, 22, 26, 39

Canvas 26
captions 19
centered 21, 63
Change Background... 16-17,
40, 51
Change Picture 16-17, 50
circular panels 60
Clear 57
clip art 24, 27
Clipboard 26, 44, 53-54, 56-57, 63
Close 51
Comic People 24, 37
Comic Strip
(in Windows menu) 11, 71

Comic window 22, 39, 40-42, 44,
46, 51-54, 57-62, 64-65,

67-71, 73

14, 42, 45, 52, 59,
63, 65, 73-74

Command key

Index




Convert Paint... 28,71
Copy 21-22, 44, 54, 63
Copy to Panel 9-10, 16, 22, 40,

43-44, 46, 61
covers background 68
Create Part... 23, 65
current panel see panel
Cut 21, 44, 53, 63
darkens background 68
DeskPaint 26
dialog balloon 37
dimensions 16
dragging objects 42, 45
Duplicate 65

£

Edit Bits... 26, 24-25, 28, 38, 56,
64-65, 68, 72-73

Edit menu 53-58, 63, 73
Edit Text... 62-64, 67
editing text 38
eraser 25, 65
File menu 46-53
Flip Horizontal 66
Flip Vertical 66
flush left 21-22, 63
flush right 21-22, 63
fonts 8, 21-22, 38
Free from Panel 70

The Comic Strip Factory User Manual

grabber 74
GraphicWorks 27
Group 68-70
group 38-39, 54, 64, 68-70
hand 25, 65
hard disk 7-8
HyperCard 12, 47

/

icon bar 12-13, 20, 23, 39,
58-59, 62, 64
Initial Layout dialog 11, 47
Install Background... 10, 14,
39-40, 49, 51
Invert 66

4

layout 11-12, 14-15, 17, 24, 47

lightens background 68
MacBillboard 27
MacDraw 12, 14-18, 23-27, 35,

37, 39, 40, 47, 49-52, 72
MacWrite 22, 40
Make Silhouette 67
MergeBits 26, 28, 68, 73
Microsoft Word 40
moving objects 42,73
MultiFinder 26
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narrative 11, 19, 37, 46, 48-49
New... 11, 19, 22, 39-40, 46
Now Printing... dialog 52
J

Objects menu 62-68
objects 36-38, 41, 56, 57, 65,

67, 69-71
Office Days 37

OK (in icon bar) 20, 22-23, 26, 39

Open dialog 9, 17, 19, 49-50, 53

Open... 9, 19, 39-40

Option key 42, 45, 55, 57, 65,

69, 73-74

Option-Paste 55, 73
p

page 36

Panel menu 58-62

panel reshaping 13, 74

panel 9, 11-14, 16-18, 20, 36,

41-42, 47, 53, 55,

61-62, 69-70

creating 59

current 13, 16, 23, 41, 43,

46, 58-62, 73

Panorama 15-16, 39-40, 50

PartMaker II 23, 26-28, 53, 71-73

parts 9, 24-25, 27-28, 37, 44,

54-55, 64-65

Parts (in Windows menu) 71

Parts window 40, 44-46, 51-54,
57, 61, 64-65, 68-69, 71

parts file 26, 37, 40

Paste 21-22, 44, 53-57, 63
patterns 60-61, 68
pencil 25, 65
Point Balloon 23, 66-67
pointer 21, 23, 26, 38, 66-67
Portrait 15-16, 39, 49
Print 52
Quit 53
R
Remove Panel 62
reshaping panels 58-60, 74
Restrict to Panel 10, 70
Rotate 66
s

Save 51
Save As dialog 51
Save As... 51
Scrapbook 23, 26
scripts 19-20, 40
selecting objects 41-42, 45
selection rectangle 42, 45, 55
Send to Back 9, 69, 73
Set Font 22, 63
Set Pattern... 55, 67
shadows 38, 67
Shift key 41-42, 45, 55, 57, 59,

69, 73-74
Shift-Paste 56, 73
Show Page dialog 58
Show Page... 11, 57
Silhouette Pattern dialog 67






